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1: Overview

INTRODUCTION

The affordable and compact SNAP PAC R-series
programmable automation controllers provide powerful,
real-time control and communication to meet your
industrial control, monitoring, and data acquisition and
exchange needs. Part of the Opto 22 SNAP PAC System ", the
R-series PAC is a rack-mounted, industrially hardened unit
that can handle multiple tasks involving digital and analog
control, serial string handling, communication, and
enterprise connectivity.

Used with the included PAC Project Basic software suite (or
PAC Project Professional, purchased separately), the
Ethernet-based SNAP PAC R-series controller runs control SNAP-PAC-R1 controller

programs written in Opto 22's PAC Control” software. It can

monitor and control a wide range of devices and equipment

wired to the 1/0 on its own rack and to I/0 on distributed racks equipped with SNAP PAC EB-series brains or
groov RIO® edge I/0 modules. Alternatively, the R-series controller can be used as a slave to a larger controller,
either a groov EPIC® edge programmable industrial controller, a SNAP PAC S-series standalone industrial
controller, or a SoftPAC™ software-based controller for PC-based control..

SNAP PAC R-series controllers are well suited to process control, discrete manufacturing, and hybrid industries
and applications.

Several models are available:

«  SNAP-PAC-R1, SNAP-PAC-R1-FM, and SNAP-PAC-R1-B each control a mix of SNAP analog, digital
(both 4-channel and high-density), and serial modules. Full digital functions include high-speed
counting; quadrature counting; and pulse, period, and frequency measurement. The -FM model is
Factory Mutual approved. The -B model is designed to mount on SNAP B-series racks so that older I/O
units can be easily upgraded to a newer controller.

«  SNAP-PAC-R2 and SNAP-PAC-R2-FM also control a mix of SNAP analog, 4-channel and high-density
digital, and serial modules. High-speed digital functions are not included. The -FM model is Factory
Mutual approved.

Built-in functions and comparisons of the SNAP-PAC-R1 and SNAP-PAC-R2 are shown in the table on page 33.
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INTRODUCTION

Ethernet Communication

All SNAP PAC R-series controllers communicate over standard 10/100 Mbps Ethernet networks and can be
attached to an existing network. The controllers can also be used in an independent control network built
with standard, off-the-shelf Ethernet hardware.

SNAP PAC R-series controllers include two 10/100 Mbps Ethernet interfaces for networking to Ethernet hosts
and to other 1/0 units. These interfaces support Auto MDI-X, which means you can use a standard
straight-through Ethernet cable; a crossover cable is not needed for direct connection to a PC. The two
independent Ethernet ports have separate IP addresses that can be used with PAC Project Professional
software to set up redundant network links to safeguard the availability and reliability of an 1/0 system, or to
segment a control system’s network from the enterprise LAN.

Supported protocols over Ethernet include EtherNetw/lP, I\/lodbus@/TCP, SMTP, SNMP, FTP, and OptoMMP.

Serial Communication

SNAP PAC R-series controllers provide an RS-232 serial link to support Point-to-Point Protocol (PPP) modem
connections—for creating TCP/IP networks over serial or PSTN (Public Switched Telephone Network) lines—
as well as remote serial device communication.

The RS-232 serial interface supports either a modem connection using PPP or general-purpose
communication with serial devices, allowing you to send and receive data from a serial device connected
directly to the controller. For additional serial interfaces, you can add one or more SNAP serial communication
modules on the rack.

NOTE: The R-series controller does not include an RS-485 port and cannot be used to control Opto 22 serial I/0
processors, such as the SNAP PAC SB-series brains. Use an S-series controller for serial brains.

I/0 Mounting Racks

SNAP PAC R-series controllers must be connected to the appropriate rack to avoid damage to the controller.
Both the SNAP-PAC-R1 and R2 are designed to work with SNAP PAC mounting racks, which are available with
4,8, 12, 0r 16 positions for Opto 22 SNAP 1/0 modules. Part numbers are SNAP-PAC-RCK4, SNAP-PAC-RCKS,
SNAP-PAC-RCK12, and SNAP-PAC-RCK16. Factory Mutual-approved versions of these racks, with part numbers
ending in -FM, are also available.

Ethernet PAC for Legacy I/0 Racks

The SNAP-PAC-R1-B is a PAC-R1 for use with older SNAP B-series racks (only B-series racks with a B in the part
number; not the SNAP-D64RS rack). This PAC provides an upgrade path from legacy brains and rack-mounted
controllers such as the SNAP-B3000-ENET or SNAP-UP1-ADS that use B-series racks. See the SNAP [/O Racks
data sheet (form 0784) for more information on racks.

The SNAP-PAC-R1-B uses the same firmware and has the same functionality as the SNAP-PAC-R1, except that
4-channel digital modules can be placed only in slots 0-7 due to limitations of the rack.

SNAP1/0

The SNAP PAC R-series controllers support all SNAP 1/O modules available on our website. SNAP digital I/0
modules contain four input or output points, and SNAP high-density digital modules contain 16 or 32 input or
output points. SNAP analog modules contain 2 to 32 points, depending on the module.
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Forward Compatibility

SNAP PAC R-series controllers are compatible with newer groov EPIC processors and groov RIO edge 1/0 units,
which add industrial internet of things (lloT) data communications and cybersecurity features to your system.
Both groov EPIC and groov RIO can be used as I/0 units with an R-series controller. If you already have R-series
controllers, you can use them as I/0 units with a groov EPIC system.

Depending on your application, consider purchasing a groov RIO edge I/0 module or a groov EPIC processor

instead of a SNAP PAC R-series controller.

« If you don't need traditional control, groov RIO offers significant security features, thousands of I/0
options, built-in lloT software, and lower cost, in a small footprint suited for hazardous industrial areas.

«  For control, groov EPIC provides system security, better performance, control programming options,
built-in lloT software, and much more.

For more information, see groov RIO and the groov EPIC system on our website, or contact our pre-sales
engineers.

PAC Project Software

SNAP PAC controllers use Opto 22's PAC Project Microsoft” Windows—compatible automation software for
programming, human-machine-interface (HMI) development, and OPC connectivity.

Two versions of PAC Project are available on our website, www.opto22.com: PAC Project Basic is free to
download; PAC Project Professional is available for purchase and download.

«  PACProject Basic includes PAC Control” for developing control programs, PAC Displayw for creating
operator interfaces, and PAC Manager™ configuration software.

«  PAC Project Professional adds expanded versions of PAC Control and PAC Display plus a SoftPAC
software-based controller for PC-based control, OptoOPCServer " software for exchanging data with OPC
2.0-compliant client software applications, and OptoDataLink " for exchanging SNAP PAC System data
with databases (including Microsoft SQL Server, Microsoft Access, and MySQL), text files, and email
systems).

You can also purchase PAC Control Professional, PAC Display Professional, SoftPAC, OptoOPCServer, and
OptoDatalink separately. For details, see the PAC Project Data Sheet (form 1699).

PAC Control Basic is a graphical, flowchart-based programming tool for machine control and process
applications. Using PAC Control, you create, download, and run strategies on a SNAP PAC or groov EPIC
controller. In addition to flowchart programming with subroutine capability, PAC Control includes a powerful,
built-in scripting language based on C and other procedural languages.

PAC Control Professional adds the ability to import legacy OptoControl strategies, support for older mistic™
serial I/0 units, and support for the dual independent Ethernet ports on a SNAP PAC controller.

The number of PAC Control flowcharts that can simultaneously run depends on the controller, but the
PAC Control strategy can contain a much larger number of flowcharts. The total number of flowcharts is
limited only by the memaory available for strategy storage.

PAC Display Basic is an intuitive HMI package for building operator interfaces, or projects, for communicating
with a SNAP PAC controller. PAC Display offers a full-featured HMI including alarming, trending, and a built-in
library of 3,000 industrial automation graphics.

PAC Display Professional adds the ability to import projects created in OptoDisplay, part of the legacy
Opto 22 FactoryFIoor software suite, and using redundant Ethernet communication links on SNAP PAC
controllers. PAC Display Professional can also connect to Ethernet-based FactoryFloor controllers running
OptoControl strategies.

SoftPAC is a software-based programmable automation controller (PAC)designed for PC-based control.
Programmed just like an Opto 22 hardware controller, SoftPAC runs your PAC Control strategy independently

SNAP PAC R-Series Controller User’s Guide 3
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on an embedded or standalone PC. SoftPAC takes advantage of a PC's speed and file capabilities for
applications requiring extended file storage, frequent access to files, or math-intensive processes.

OptoOPCServer is a fast, efficient OPC 2.0-compliant server for communicating with many Opto 22 products,
including SNAP PAC controllers and I/0 units, plus legacy Opto 22 Ethernet-based controllers and I/O. Using
OptoOPCServer, you can consolidate data from all these Opto 22 systems into the OPC client software of your
choice, such as third-party HMI and data acquisition packages, and custom software applications you create
with tools such as Visual C++ .

OptoDataLink is a software application that makes it easy to share data from the SNAP PAC System with
commonly used databases, including Microsoft SQL Server, Microsoft Access, and MySQL, as well as text files.
The 1/0 points and strategy variables already created in your PAC Control strategy are automatically available
for OptoDatalink to use for data exchange.

PAC Manager is a utility application for assigning IP addresses to SNAP PAC controllers and brains, reading or
changing basic controller configuration, and configuring and testing 1/0.

For Developers: SNAP PAC REST API

If you're a developer who'd like to use PAC Control strategy tags in communications with other devices, the
Opto 22 SNAP PAC REST APl s a secure and powerful way to do just that. The APl is available in SNAP PAC
R-series and S-series controllers with PAC firmware R9.5a and higher. To configure https access to your PAC's
RESTful server and learn how to call the AP, visit developer.opto22.com.

ABOUT THIS GUIDE

This guide shows you how to install and use SNAP PAC R-series controllers. This guide assumes that you have
some familiarity with TCP/IP and Ethernet networking. If you are not familiar with these subjects, we strongly
suggest you consult commercially available resources to learn about them before attempting to install or use
SNAP PAC R-series controllers.

If you are using Modbus/TCP for communicating with SNAP PAC R-series controllers, this guide assumes that
you are already familiar with Modbus/TCP. See the Modbus/TCP Protocol Guide (form1678) for additional
information.

If you are using EtherNet/IP for communication, you should already be familiar with EtherNet/IP. See the
EtherNet/IP for SNAP PAC Protocol Guide (form 1770).

The following sections are included in this user's guide:
Chapter 1: Overview—information about the guide and how to reach Opto 22 Product Support.
Chapter 2: Installation—quick-start steps to get SNAP PAC R-series controllers up and running quickly.

Chapter 3: System Information—conceptual information on networking and communicating with SNAP
PAC R-series controllers; descriptions of features, capabilities, and specifications for SNAP PAC R-series
controllers.

Chapter 4: Maintenance and Troubleshooting—assigning and changing IP addresses, resetting the
controller to factory defaults, using the microSD slot, upgrading firmware, and tips for resolving difficulties you
may encounter while working with SNAP PAC R-series controllers.

Appendix A: SNAP Mounting Racks and Power Supplies— wiring diagram examples for assembling your
SNAP PAC R-series controller, SNAP PAC rack, and power supply.
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RELATED DOCUMENTATION

You'll find most of the documentation to build and maintain your control system in the PAC Project folder
that's added to your Windows Desktop when you install PAC Project. While using PAC Project applications, you
can getonline help by clicking Help in the menu bar or the Help buttons in dialog boxes, or simply by pressing
the F1 key.

Here's a brief list of documents you may find helpful. You can also download other documents, sample files,
software utilities, technical notes, integration kits, and much more from the Opto 22 website.

TIP: To easily find documents on our website, search on the form number.

For this information

Assigning IP addresses, loading new firmware,

See this guide

, il

configuring SNAP 1/O points and system functions PAC Manager User's Guide 1704
PAC Control User’s Guide' 1700

SDyeSstEn:mg flowchart-based control programs for the PAC Control Command Reference’ 1701
PAC Control Commands Quick Reference 1703

Securely accessing data in the PAC via its REST APl developer.opto22.com -

Programming your own applications by using either:

¢ The OptoMMP protocol for memory-mapped

controllers and brains OptoMMP Protocol Guide 1465
* One of the OptoMMP Software Development Kits
(SDKs)

Using redundant controllers SNAP PAC System Redundancy User's Guide 1831

Installing and using SNAP PAC S-series controllers ~ SNAP PAC S-series Controller User’s Guide 1592

Installing and using SNAP PAC R-series controllers ~ SNAP PAC R-series Controller User’s Guide 1595

Lnslliae) ETate] VT g S (2a(5 22 e SNAP PAC Brains User’s Guide 1690

SB-series brains

Communicating with I/O units using OPC OptoOPCServer User’s Guide 1439

Communicating with 1/0O units using Modbus/TCP Modbus/TCP Protocol Guide 1678

Communicating with I/O units using EtherNet/IP EtherNet/IP for SNAP PAC Protocol Guide 1770

DL DD SN AP OB Tl SNAP PAC System Migration Technical Note ~ 1688

hardware and software

1 If you are using a SNAP PAC controller with legacy I/0 units (for example, mistic /O units or Ultimate 1/0),
use the Legacy versions of these documents instead:

s egacy Edition, PAC Control User’s Guide, form 1710

e[ egacy Edition, PAC Control Command Reference, form 1711

e[ egacy Edition, PAC Manager User’s Guide, form 1714

FOR HELP

If you have problems installing or using SNAP PAC R-series controllers and cannot find the help you need in
this guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free NOTE: Email messages and phone calls
in the US. and Canada) to Opto 22 Product Support are
951-695-3080 grouped together and answered in the
Monday through Friday, order received.
7 a.m.to 5 p.m. Pacific Time

Email: support@opto22.com

SNAP PAC R-Series Controller User’s Guide 5


https://www.opto22.com/support/resources-tools
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
mailto:support@opto22.com
https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
https://www.opto22.com/support/resources-tools/documents/1701-pac-control-command-reference
https://www.opto22.com/support/resources-tools/documents/1703_pac_control_commands_quick_reference-pdf
http://developer.opto22.com/
https://www.opto22.com/support/resources-tools?keyword=optommp%20software%20development%20kit%20sdk&rt=2&tag=&numres=25&tp=0&page=1
https://www.opto22.com/support/resources-tools?keyword=optommp%20software%20development%20kit%20sdk&rt=2&tag=&numres=25&tp=0&page=1
https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1831-snap-pac-redundancy-option-user-s-guide
https://www.opto22.com/support/resources-tools/documents/1592-snap-pac-s-series-users-guide
https://www.opto22.com/support/resources-tools/documents/1595-snap-pac-r-series-users-guide
https://www.opto22.com/support/resources-tools/documents/1690-snap-pac-brains-users-guide
https://www.opto22.com/support/resources-tools/documents/1439-optoopcserver-user-s-guide
https://www.opto22.com/support/resources-tools/documents/1678-modbus-tcp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1770_ethernet_ip_for_snap_pac_protocol_guide-pdf
http://www.opto22.com/site/documents/drilldown.aspx?aid=3149
https://www.opto22.com/support/resources-tools/documents/1710-legacy-edition-pac-control-user-s-guide
https://www.opto22.com/support/resources-tools/documents/1711-legacy-edition-pac-control-command-reference
https://www.opto22.com/support/resources-tools/documents/1714-pac-manager-users-guide-legacy-edition

FOR HELP

Opto 22 website: WWW.opto22.com

When calling for technical support, be prepared to provide the following information about your system to
the Product Support engineer:

«  Version of this product
«  PCconfiguration (type of processor, speed, memory, operating system)
«  Complete description of your hardware system, including:

- Jumper configuration

- Type of power supply

- Types of I/0 units installed

- Controller firmware version

- Specific error messages
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2: Installation

If you already know how you will use the SNAP PAC R-series controller and want to get it running quickly,
follow the sections in this chapter.

To learn about communication options and networking, start on page 13. Specifications are listed on page 27.

WHAT YOU WILL NEED

You'll need the following items to install a SNAP PAC R-series controller:
«  APCrunning Microsoft® Windows® 10 Professional (32-bit or 64-bit)

«  Foran Ethernet connection, the PC also needs a 10/100 MB Ethernet adapter card, the TCP/IP protocol
installed, and a valid IP address, on the same subnet as the controller. (For more information, see
“Networking”on page 22.) In addition, you need a standard Ethernet cable for direct connection to the
PC (recommended), or an available connection to a standard T0BASE-T or T00BASE-TX Ethernet network.

o SNAP PAC R-series controller

»  SNAP PAC mounting rack and SNAP /O modules. Choose rack and modules based on your needs.
(Exception: a SNAP-PAC-R1-B uses a B-series rack, not a SNAP PAC rack.)

o ASNAP-PS5 or SNAP-PS5U power supply or other 5VDC power supply (5.0 to 5.2 VDC at 4.0 A) applied to
the rack. Additional power may be required for SNAP 1/0 modules and depends on the number and type
of modules used. For more information, see “Determining Power Requirements”on page 61.

«  (Recommended) PAC Project Basic or PAC Project Professional (available from the Opto22 website)

INSTALLING HARDWARE

Assemble the rack and power supply according to the directions that came with them. For help with wiring,
see the product data sheets, which are available on our website at www.opto22.com.

Installing Modules on the Rack

CAUTION: Make sure you are using the correct rack for your controller. All SNAP PAC R-series controllers except the
SNAP-PAC-R1-B use a SNAP PAC rack. SNAP-PAC-R1-B uses a B-series rack (with a Bin the part number; this controller
does not work on a SNAP-D64RS rack). Using the wrong rack will severely damage the controller.

Modules snap into position in the row of connectors on the SNAP PAC rack. Each module connector has a
number.

NOTE: R-series controllers with serial numbers lower than 600,000, and all SNAP-PAC-R1-B controllers, are limited to
eight 4-channel digital modules per rack, located in the first eight positions.

SNAP PAC R-Series Controller User's Guide 7


https://www.opto22.com
https://www.opto22.com/search?searchtext=pacproject&searchmode=anyword

INSTALLING HARDWARE

1. Place the rack so that the module connector numbers are right-side up, with zero on the left.

Controller Module SNAP PAC racks are shown in all illustrations.
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2. Position the module over the module connector, aligning the small slot at the base of the module with
the retention bar on the rack.

3. With the module correctly aligned over
the connector, push on the module to Module keys
snap it mtg .pIaFe. &
When positioning modules next to each @ '
other, be sure to align the male and
female module keys (shown in the
detailed view in the illustration at right)
before snapping a module into position.

!

Modules snap securely into place and
require a special tool (provided) to
remove them. To remove a module, see
the next section.

4. (Optional) Use standard 4-40 x 1/4
truss-head Phillips hold-down screws to
secure both sides of each module. Do not
overtighten screws.

Optional hold-
down screws

5. Plug the wiring connector into each
module to attach modules to the devices
they monitor.

See the wiring diagrams in the module’s data sheet.
6. Continue with “Installing the Controller”on page 9.
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Removing a Module

1.

If the modules are held in place with screws,
remove them.

Holding the SNAP module tool (provided) as
shown in the illustration at right, insert it into
the notch at the base of the module.
Squeeze the module tool against the module
to open the release latch, and pull straight up
on the module to remove it.

Installing the Controller

CAUTION: Make sure you are using the correct rack

for your controller. All SNAP PAC R-series controllers

except the SNAP-PAC-R1-B use a SNAP PAC rack (or a legacy SNAP M-series rack). SNAP-PAC-R1-B uses a B-series rack
(with a Bin the part number; this controller does not work on a SNAP-D64RS rack). Using the wrong rack will severely
damage the controller.

Remove the controller from its packaging.
Turn off power to the rack assembly.

Align the controller connector with the mating
connector on the mounting rack.

Seat the controller onto the connector and use
the hold-down screw to secure the controller in
position. Torque: 8 Ibf-in (0.9 N-m). Do not
overtighten.

Using Category 5 or superior solid unshielded

twisted-pair cable, connect the controller in one

of the following ways:

- (Recommended for initial configuration)
Connect to a PC directly, using a standard
Ethernet cable.

—  Connect to a standard 10BASE-T or T00BASE-TX Ethernet network that has a PC on the same subnet
as the controller and does NOT have a Dynamic Host Configuration Protocol (DHCP) server.

NOTE: When connecting the controller to a managed switch, make sure the managed switch's port
configuration is set to Auto for the Duplex setting and Auto for the Speed setting.

Maximum cable or segment length is 100 meters; minimum cable length is one meter.
See the Appendix (page 59) for information on power supplies and wiring.

Before turning on power to the controller, follow steps in the PAC Manager User’s Guide (form 1704) to
assign the controller an IP address.

For controllers used with a modem: Follow the steps in “Using PPP Over a Modem"on page 11.
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WHAT'S NEXT?

WHAT'S NEXT?

10 SNAP PAC R-

To start configuring controllers and 1/0 points, see “Configuring I/0,” below.

To learn more about SNAP PAC R-series controller capabilities and network options, see Chapter 3: System
Information.

To create PAC Control strategies to run on the controller, see the PAC Control User’s Guide (form 1700) and the
PAC Control Command Reference (form 1701). Both are available in PDF format and you can download them
free from our website, www.opto22.com.

To securely access data from /0 points and strategy variables in the PAC via its RESTful API (application
program interface based on the REST architecture), see developer.opto22.com.

To work with the following items on the controller, see instructions in the PAC Manager User’s Guide:
«  File system and FTP

«  Security settings

«  Portand interface configuration

To use OLE for process control (OPC) with SNAP PAC R-series controllers, purchase OptoOPCServer and see the
OptoOPCServer User’s Guide (form 1439).

To communicate with controllers using Modbus/TCP, see the Modbus/TCP Protocol Guide (form1678).

To communicate with an Allen-Bradley Logix PLC or other system using EtherNet/IP, see the EtherNet/IP for
SNAP PAC Protocol Guide (form 1770).

To program your own applications, see the OptoMMP Protocol Guide (form 1465).

Configuring 1/0

No matter how you communicate with SNAP PAC R-series controllers, you will need to configure I/0 points
and controller features.

If you are not using PAC Control (Opto 22's flowchart-based control software), follow instructions in the
PAC Manager User’s Guide (form 1704).

If you are using PAC Control, I/0 units and points must be configured to match the PAC Control strategy
you will run. You can configure most controller features and point functions either in PAC Control or in PAC
Manager.

In most cases, if you are already in PAC Control, configuration is easier there and you can use the loopback [P
address for SNAP PAC R-series controllers controlling themselves. However, some functions cannot be
configured in PAC Control.

If you use PAC Manager, you can save your configuration to a file, load it to multiple I/0 units at once, and use
it for referencing points in OPC. You can also configure some controller features that are not available in PAC
Control. However, you cannot use the loopback address in PAC Manager.

See the table on the next page for a summary of which tool to use, based on your application.
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Choose your configuration tool based on what you need to do:

Use PAC Control for I/0O configuration if... Use PAC Manager for I/O configuration if...

You have only one I/0 unit or I/O unit configurations are «  You have multiple I/0 units whose configurations are exactly
different. the same or similar.

+  The strategy will run on I/0 units that are controlling +  Youare using a modem connection (PPP) or SNMP.
themselves using the loopback IP address (127.0.0.1). +  Youare using event messages or email.
You are using an Ethernet network for communications. « You are configuring events and reactions on the I/O unitin
The strategy handles all logic; you are not also configuring addition to strategy logic.
events and reactions on I/0 units. «  Youare using OPC to communicate with I/ units.

«  Youare not using PAC Control.

IMPORTANT: Whichever tool you use for configuring 1/0, be aware of the impact if you later change
configuration. For example, if you configure I/0 in PAC Manager, download the configuration file to 1/0 units,
and then later add a point in PAC Control, remember that your configuration file doesn’t contain that point.

USING PPP OVER A MODEM

Use the rest of this chapter only if you have SNAP PAC R-series controllers installed at remote locations or in
other places where an Ethernet network is not available, and you are using modems to communicate
between the controller and a PC. The modems use the point-to-point protocol (PPP) to communicate. You
can set up communication so that the controller can dial in to a PC, so that PCs can dial into the controller, or

both.
PCdialsinto
controller

4 # SNAPPACR-series Modem SN
[ controller '
: . y ., :
Modem
PC with dial-up
i 4%% networking
W
Modem S
i X 5

NOTE: You can communicate with a SNAP PAC R-series controller using a modem and PPP at the same time you are
communicating with the controller over an Ethernet network.

Here's how to set up PPP:

1. Use PAC Manager to assign an IP address to the SNAP PAC R-series controller, following the instructions in
the PAC Manager User’s Guide.

2. Follow steps in the next section to configure PPP.
3. Attach the modem to the system, following the steps below.
Set up Windows dial-up networking on the PC.
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Configuring PPP on the Controller

To configure PPP on the SNAP PAC R-series controller, see instructions in the PAC Manager User’s Guide
(form 1704). Also use this guide to assign an IP address to the Ethernet ports, configure points, and store
configuration to flash.

Attaching the Modem to a SNAP PAC R-Series Controller

Once the controller and I/0 points are configured and communication has been tested, follow these steps to
attach the modem to the controller. To work properly with the controller, a modem must be able to store
settings in non-volatile RAM (NVRAM) and default to those settings on reset.

IMPORTANT: Any modem used with the controller must implement the Carrier Detect (CD) signal or use a custom
cable that connects CD to Data Terminal Ready (DTR) on the controller side.

1. Use the following diagram to attach the modem to the controller using the serial connector. As shown
here, you can use either a DB9 or a DB25 connection.

Modem Controller Modem Controller
DB9 DB25
DCD 1 8 DCD TD 2 1 TX
RX 2 2 RX RD 3 2 RX
TX 3 1 TX RTS 4 4 RTS
DTR 4 7 DTR CTS 5 5 CTS
RTS 7 4 RTS SG 7 30r6 COM
CTS 8 5 CTS CD 8 8 DCD
SG 5 3or6 COM DTR 20 7 DTR

NOTE: Pins 3 and 6 are tied together within the SNAP PAC R-series controller, so no external jumper is required.

2. Store configuration settings to the modem’s NVRAM, following instructions in the user’s guide for your
modem.

NOTE: Configuration settings must be stored to the modem’s NVRAM so they will be loaded when the SNAP PAC
R-series controller sends a reset command to the modem.

3. If PCs will dial up the controller, set up Windows dial-up networking on the PCs that will call the
controller.
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3: System Information

This chapter explains how to use SNAP PAC R-series controllers in an Ethernet network and how to
communicate with them. It also provides information on system architecture, specifications, and features.
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COMMUNICATION OPTIONS

SNAP PAC R-series controllers communicate using TCP/IP or UDP/IP over an Ethernet network.

Physical Layer—All SNAP PAC R-series controllers communicate over a 10- or 100-Mbps wired Ethernet link.
SNAP PAC R-series controllers can also communicate using a modem over PPP,

Transport Layer—The key to SNAP PAC R-series controller communication flexibility is the transport layer,
Internet Protocol (IP). Both the Transmission Control Protocol (TCP) and the User Datagram Protocol (UDP) are
used with IP.

Application Layer—Because SNAP PAC R-series controllers use standard IP for the transport layer, many
communication options are possible in the application layer. After the controller is installed and has an IP
address assigned (see page 9), you can communicate with it using the following methods:

PAC Manager software utility is used for assigning IP addresses, configuring 1/0 points and features, and
performing onetime reads and writes.

PAC Control strategies running on a groov EPIC or SNAP PAC System industrial controller can configure,
read, and write to I/O points on R-series controllers.

Custom applications using the PAC’s RESTful APl and HTTP/HTTPS server let you securely access
data using the language of your choice, including PHP, JavaScript, .NET, Perl, and others. Data is returned
as JSON. See the APl and instructions at developer.opto22.com.

Custom software applications can also be built using our OptoMMP Software Development Kits
(SDKs) for C++ and .NET. They use OptoMMP, an IEEE 1394-based protocol. to read and write to SNAP PAC
R-series controllers. The C++ SDK supports Linux® and Windows® platforms; the NET SDK is for Windowvs.
For developers not using Microsoft Windows, the OptoMMP protocol is open and documented.
EtherNet/IP provides communication with Allen-Bradley ControlLogix® and CompactLogix™ PLC
systems and other systems using the EtherNet/IP protocol. Both implicit and explicit messaging are
supported.
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«  Modbus/TCP provides a direct connection with Modbus/TCP hardware or software or third-party
software applications, which can read or write to I/0 points on SNAP PAC R-series controllers.

o OPC (OLE for Process Control) uses OptoOPCServer to serve controller data to any OPC 2.0-compliant
application, such as an HMI, which can also read or write to /0 points. OptoOPCServer can be purchased
separately or as part of the PAC Project Professional software suite.

«  SMTP (Simple Mail Transfer Protocol) connects a SNAP PAC R-series controller with corporate email
servers, so employees can be emailed or paged if there’s a problem on devices attached to the controller.

«  SNMP (Simple Network Management Protocol) makes it possible to monitor devices attached to SNAP
PAC R-series controllers just as you would any computer or server on the Ethernet network, using an
SNMP-based enterprise management system such as Computer Associates’ Unicenter’,
Hewlett-Packard’s OpenView', or BM's Tivoli". When a monitored event occurs, such as a door left open
or a pressure level too high, the controller sends an SNMP trap to the management system.

«  FTP (File Transfer Protocol) can be used to transfer files and data to and from the SNAP PAC R-series
controller, whether to custom applications, enterprise databases, or any file system. R-series controllers
manufactured after November 2008 include removable storage capability: a microSD card slot. See
page 37 for information on using the card for storage and for loading firmware or PAC Control strategies
to the controller.

Simultaneous Communication

In addition to communicating using all the methods listed above, each SNAP PAC R-series controller can also
communicate simultaneously using all applicable methods.

The reason lies in the nature of IP. In serial communication, a single data request is sent by one device to
another. The first device must wait for a response before any additional communication can be carried out. IP,
however, can establish multiple simultaneous sessions, so many data requests can be sent at once without
waiting for any individual response. Each request gets a response, but the link isn't idle while waiting for
responses.

In addition, IP can simultaneously handle multiple requests from multiple devices. A PC can communicate
with all SNAP PAC R-series controllers on the same network—all at the same time—and multiple PCs can
communicate with one controller at the same time.

So, for example, a SNAP PAC R-series controller can respond to directions from a Modbus master, give analog
point data to a technician using PAC Manager, and carry out instructions from a custom C++ application—all
at once.

Accessing SNAP R-Series Controllers over the internet

Since SNAP PAC R-series controllers are just like any other hardware on the Ethernet network, you can access
them over the internet in exactly the same way you would access a computer. The details depend on your
network and internet connection. Consult your system or network administrator or your Internet Service
Provider (ISP) for more information. Also see the Guide to Networking Opto 22 Products (form 1796).
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CHAPTER 3: SYSTEM INFORMATION

How do you need to communicate with SNAP PAC R-series controllers to match the tasks your application
requires? Check the following table for help in choosing communication methods and finding more
information on them.

This task

Can be done using these methods

Recommended

Alternate

Details and references for information

Configure controllers.

Monitor and control processes.

Send email to or page someone.
Send SNMP trap.

Monitor devices through an
enterprise management system.

Give technicians an Opto 22 HMI
with alarming and trending.

Give technicians a mobile opera-
tor interface for monitoring and
controlling systems/equipment

Monitor and control SNAP PAC
R-series controllers on the net-
work.

Share strategy variable data with
Opto 22 controllers and other
SNAP PAC R-series controllers
(peer-to-peer communication).

Securely access /O point and
variable data for use in data-
bases, other systems, or internet
of things (loT) applications
Communicate with Modbus/TCP
hardware or software.

Communicate with Allen-Bradley
Logix PLC systems

Exchange 1/O point data with
third-party software such as
HMls.

PAC Manager (I/0
points and other
functions) or PAC
Control (I/O points
only)

For A-B systems,
use EtherNet/IP
Configurator.

PAC Control flow-
chart logic

PAC Manager (for
configuration),
PAC Control

PAC Display

groov View

PAC Control

PAC Control
(writes to memory
map Scratch Pad
areas)

PAC’s RESTful API
and HTTP/HTTPS
server

Modbus/TCP

EtherNet/IP

OptoOPCServer
and controller's
memory map

OptoMMP Software
Development Kit or
IEEE 1394-based
protocol.

PAC Manager
Inspect window or
OptoMMP Software
Development Kit or
IEEE 1394-based
protocol

OptoMMP Software
Development Kit or
IEEE 1394-based
protocol

Other programming
tool with groov EPIC
processor

Memory map
Scratch Pad areas

loT software built
into groov EPIC pro-
cessor

loT software built
into groov EPIC pro-
cessor

If you are using PAC Control, configure the system in PAC
Control configure mode. See the PAC Control User’s
Guide.

For A-B systems, see EtherNet/IP for SNAP PAC Proto-
col Guide.

For the Software Development Kit or IEEE 1394-based
protocol, see OptoMMP Protocol Guide.

See PAC Control User’'s Guide & Command Reference.
CAUTION! Events and reactions set up using alternate
methods are faster than flowchart logic, but be careful if
you use them. They can conflict with PAC Control logic,
because both write to the controller's memory map. For
Software Development Kit or IEEE 1394-based protocol,
see OptoMMP Protocol Guide.

If you are using PAC Control, configure email using PAC
Manager. See the PAC Manager User’s Guide.

For Software Development Kit or IEEE 1394-based proto-
col, see OptoMMP Protocol Guide.

See PAC Display User’s Guide.

Requires groov Server for Windows or a groov EPIC pro-
cessor.

PAC Control with a groov EPIC, SNAP PAC R-series, or
SNAP PAC S-series controller (see PAC Control User’s
Guide & Command Reference)

See groov EPIC system.

PAC Control does not write directly to peers, but places
data in the memory map so peers can retrieve it by read-
ing memory map addresses.

See PAC Control User’s Guide & Command Reference.
Also see controller's memory map in OptoMMP Protocol
Guide.

See the API and instructions at developer.opto22.com.
See groov EPIC system.

See the Modbus/TCP Protocol Guide (form1678).

See the EtherNet/IP for SNAP PAC Protocol Guide
(form 1770).

Purchase OptoOPCServer separately. See OptoOPC-
Server User’s Guide and the memory map in OptoMMP
Protocol Guide.

See groov EPIC system.
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This task

Can be done using these methods

Details and references for information

Recommended Alternate

Exchange PAC Control strategy
variable data with third-party soft-

ware such as HMIs.

Write your own software applica-
tion to communicate with the sys-

tem.

FTP and control- OptoOPCServer or  Purchase OptoOPCServer separately. See PAC Control
ler's file svstem built-in 10T software  User’s Guide and OptoOPCServer User’s Guide.
y in groov EPIC See groov EPIC system.

C++ or Active X:
OptoMMP Com-
munication Toolkit
and controller's
memory map.

Opto 22’s IEEE
1394-based proto-
col and controller's
memory map.

See OptoMMP Protocol Guide.

SYSTEM ARCHITECTURE

Because SNAP PAC R-series controllers are a combination of controller and /0 processor, their architecture is
more complex than that of devices such as the SNAP EB-series brains, which are I/0 processors only. The next
few pages show the capabilities of this versatile system, starting with the simplest and moving to the more
complex. Your application may require only some of these capabilities, but as your needs expand, remember
that SNAP PAC R-series I/0 can be used in all the ways shown, simultaneously.

Understanding the SNAP PAC R-series Controller

The SNAP PAC R-series controller merges two functions that are usually located in separate pieces of hardware:
input/output processing and flowchart-based control. These two functions are handled by two “sides” of the
controller, as illustrated below.

Controller  1/0 Modules
|
o LR LR SR :
T
| % L} =2 ' The rack is shown with the SNAP PAC

R-series controller on the left and the
input/output modules on the right.

The modules on the rack connect to
devices in the real world, such as the
light bulb, to monitor or control them.

Control Side
Turn on point

I/O Side

Start Status
Checks

Start system

Run PAC Control flowcharts | Read and write to I/O points

using Memory Map

The I/0 Side of the Controller

The controller reads and writes to the I/0 points using its I/O side memory map. This side of the SNAP PAC
R-series controller is like SNAP EB-series brains.

You can think of the controller's memory map as a grid of mailboxes, with each mailbox having its own
memory address. Each mailbox address has a specific purpose. For example, one address holds the state of a
single digital point; another address holds counter data for the same point. There's an address that stores the
controller's firmware version, one that contains the minimum value of a specific analog point, and many more.
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If you are familiar with programmable logic controllers (PLCs), you'll see that the memory map is similar to a
register.

Most SNAP PAC R-series controllers run PAC Control flowcharts that automatically manipulate the memory
map, so you probably won't need to understand it in detail. If you do need to refer to it, however, the complete
list of memory map addresses is in the OptoMMP Protocol Guide, (form 1465).

The Control Side of the Controller

The control side of the controller is like a traditional Opto 22 industrial controller. In the control side, the
controller runs PAC Control flowcharts. These flowcharts provide the logic that controls processes through the
system. Commands within the flowchart read from and write to the memory map in the I/0 side of the
controller in order to monitor and control the I/0 points.

Controlling the System

The flowcharts that run in the control side of the controller are created in PAC Control, a software application
included with the SNAP PAC R-series controller. You create these flowcharts as part of a control strategy and
download the strategy to the controller, and the controller runs it independently. For information on using
PAC Control, see the PAC Control User's Guide (form 1700) and the PAC Control Command Reference (form 1701).

You use PAC Control on a PC connected to the network, so you can create your control strategy and download
it to the controller. Also included with the SNAP PAC R-series controller is PAC Display, a full-featured
human-machine interface (HMI). PAC Display uses the same tag database as PAC Control, so points and
variables are already defined. Operators, technicians, and engineers running PAC Display on a Microsoft
Windows-based PC on the Ethernet network can see the information they need, as well as plot trends and
respond to alarms.

For applications that require more than one I/0 unit, the SNAP PAC R-series controller can control multiple I/0
units through the flowcharts on its control side. These I/0 units can be located where needed on the Ethernet
network for distributed control.
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The following diagram shows the control side of the controller:

SNAP PAC R-series
1/0 Unit

;é ‘ | Shared tag

¢

database

Control Side : I/0 Side
=== :.n PAC Control flowcharts : Read/write to points
: using Memory Map
PAC Control :
Use to create flowcharts H P
and download strategy to : '
SNAP PAC R-series H Memory Map

PAC Display
Uses the same tag
database as PAC
Control

Other Ethernet-based I/0 units

Using Data for Peer-to-Peer Communication

What if you have multiple SNAP PAC controllers? What if each one is running a different PAC Control strategy,
and they need to share variable data? Or what if you need to share data between a SNAP PAC System and an
Allen-Bradley Logix-based PLC?

Scratch Pad areas within the SNAP PAC R-series controller's memory map provide a way for other devices on
the Ethernet network to access data in the controller. For descriptions of the Scratch Pad areas—bits, integers,
floats, and strings—see the PAC Manager User’s Guide. For help in using PAC Control commands to access
Scratch Pad areas, see “I/O Unit—Scratch Pad Commands”in Chapter 10 of the PAC Control User’s Guide. For
information on communicating with an A-B Logix PLC, see the EtherNet/IP for SNAP PAC Protocol Guide.
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The following illustration shows how this type of peer-to-peer communication can be done using PAC
Control.

The memory map in the
controller's 170 side has two
parts: the fixed area and the
Scratch Pad area.

/w The fixed memory area is used

automatically by the controller
B to read and write data to I/0

SNAP PAC R-series
1/0 Unit

g — points; each address has a fixed
' ' purpose.
- The Scratch Pad area, however,
Control Side 1/0 Side is user-defined; it is available for
Run PAC Control flowcharts H Read/write to points you to define and use as needed
using Memory Map in order to exchange data
! e e | | e
: -:E-// 1170 point data) HH The Scratch Pad area includes
T 3 riatch ]'piafd:;:ar:e:af = L: five sections so you can use
o & Sirategy variable data) different types of data: bits,
Shared tag 32-bit and 64-bit integers, floats,
database \ and strings.

Using PAC Control commands in
its flowcharts, the first SNAP PAC
R-series controller can write
strategy variable data to its
] Scratch Pad area. Other SNAP
" PAC controllers can use similar
commands in their own
flowcharts to read the data from the Scratch Pad area of the first controller. Similarly, another unit or controller
can write to the Scratch Pad area of the first controller, which can then read the data deposited in its own
Scratch Pad area by the peer. The reading and writing of data by peers to the Scratch Pad area must be very
carefully coordinated in order to avoid conflicts.

= “!\T

T

For more information on using PAC Control commands for peer-to-peer communication, see “Communication
Commands”in Chapter 10 of the PAC Control User’s Guide and individual commands in the PAC Control
Command Reference.

If you are not using PAC Control but writing your own software applications to access the Scratch Pad areas,
see the OptoMMP Protocol Guide. This guide is written for /O units, but much of the same information on
programming applies to SNAP PAC controllers. The Scratch Pad areas of the memory map are described in the
programming guide’s appendix.

Communicating with Enterprise Systems and Third-Party Software

In addition to its capabilities in /0, control, and peer-to-peer communication, the SNAP PAC R-series I/0
system can also interface directly with enterprise systems and third-party software that need to use its data.
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The following graphic shows how these software applications (and some hardware, too) can directly access
the memory map in the controller's 1/0 side for both 1/0 point data and strategy variable data.

>_/< Paging
Enterprise
[ management
SNAP PAC R'Series System
controller
All protocols except S Modbus/TCP
/> FTP can read or write \\\\\\\;{ hardware and
\ ) 101/0 points directly EE i software
~—| through the Memory
— Map. 3rd-party
— software
* Intellution
Control Side 1/0 Side * Wonderware
Run PAC Control flowcharts £ Read/write to points )
: SMTP ActiveX custom
: using Memory Map licati
S e —— SNMP application
i _FHrixed memory area Modbus/TCP __| (VB, C, C++,
: O pointdata) A 1394-based database)
¢ |4 Scratch pad ared
R &= inam 11 iahle —
: K — Enterprise
oPC database
FTP o
:g;f/ I-:T:F:S server All protocols except FTP Any OPC
u can also read strategy client software
| variable data from the
Databases Scratch Pad area of the
Other systems Memory Map.
loT applications I — File system

All of the protocols shown in the diagram, except FTP, can be used to communicate with both the fixed
memory map area and the Scratch Pad area, so you can access both /O point data in the fixed area and
strategy variable data placed in the Scratch Pad area. In addition, strategy variable data from the PAC Control
database can be directly used by OPC clients.

FTP can be used to access files on the SNAP PAC R-series controller, which are on the control side but can
contain data from the I/0 side (or any other data). For more information on the controller’s file system and FTP,
see the PAC Control User’s Guide and the PAC Manager User’s Guide.

The Complete System

When all these capabilities we've discussed are put together, you can see the versatility—and the wealth of
applications—of the SNAP PAC R-series 1/0 system, shown on the following page.
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NETWORKING

From a physical standpoint, SNAP PAC R-series controllers can be networked in several ways:
«  Connected directly to a PC or controller using a standard Ethernet cable

«  Attached to an existing TCP/IP Ethernet network

«  Aspart of an independent network built with standard Ethernet hardware

«  Overamodem connection

The networking method you use depends on several things, including whether you need control or data
acquisition, the number of PCs, controllers, and I/0 units you are using, the speed and volume of
communication, security requirements, and the availability of an existing network. (For more information on
networking, see the Guide to Networking SNAP PAC Products, form 1796.)

Connecting the Controller Directly to a PC or Master Controller

A direct connection connects just one SNAP PAC R-series controller with one host. The Ethernet interface(s) on
the controller support Auto MDI-X, which means you can use a standard straight-through Ethernet cable; a
crossover cable is not needed for direct connection to a PC.

A direct connection is quick, easy to do, and provides high speed and high security for a small system. It is
useful for assigning an IP address, configuring I/0 points, and testing applications on I/O units that will be
used later on a network. The direct connection eliminates other variables that could interfere with
communication, so you can focus on maintenance and troubleshooting.

Attaching the Controller to an Existing Ethernet Network

The first rule in attaching SNAP PAC R-series controllers to an existing network is to work closely with your
system administrator, who must determine network topology and hardware. Be sure to consider the impact
on your existing network of adding the controllers.

In addition, make sure the system administrator understands that each controller must have a fixed (static) IP
address, whether or not a Dynamic Host Configuration Protocol (DHCP) server is used on the network. For
more information on IP addresses, see the PAC Manager User’s Guide.

If you are using SNAP PAC R-series controllers for data acquisition, you can place the controller anywhere on
an existing Ethernet network. If you are using the controller with control applications, however, the network
design will depend on the number of hosts, the number of data transactions, and issues of data security. With
fewer hosts and fewer data transactions, data packet collisions are less likely and system performance
improves. If collisions are a problem, and especially if you need high throughput and predictable response
times, it's best to put the controller on a separate switched network segment. We recommend switches, not
hubs. For best performance, use a 100 Mbps network.

Isolating the Control Network in a Separate Zone

NOTE: This implementation requires PAC Project Professional. For more information, see the SNAP PAC R-series data
sheet (form 1594) and the SNAP PAC S-series data sheet, form 1584). You may also consider using a router, network
switch, or other gateway device.

If you need to isolate your trusted control system network from an untrusted network (for example, a
company network that accesses the internet), you can use the two Ethernet interfaces on either the SNAP PAC
R-series or an S-series controller to create separate zones. One interface can be connected to the trusted
network, and the other used for the untrusted network. See the diagram on page 25.
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Using the Controller in an Independent Network

The third way SNAP PAC R-series controllers can be used is by developing an independent network. An
independent network gives a high level of communication speed and volume, as well as high security. If you
have no existing Ethernet network, you can use off-the-shelf Ethernet components to build one. Consider
using industrial-grade Ethernet components for harsh and challenging environments.

You may also need a separate network for critical control applications. Again, the choice depends on your
requirements for data transactions, data security, and whether a near-deterministic system is necessary.

If you are building your own network, remember that each controller must have a fixed IP address. See the
PAC Manager User’s Guide for more information on IP addresses.

Since Ethernet and TCP/IP are worldwide standards, there are a number of commercially available resources
for learning about building and maintaining such a network. We strongly suggest you learn as much as
possible about the subject and plan your network carefully before beginning, in order to get the best
performance from your system.

Communicating with the System via Modem

Afourth way to use a SNAP PAC R-series controller is with a modem connection, useful for remote installations
(for example, a communication tower or a pipeline) or in other places where a wired Ethernet network is not
practical. Communication via modem uses the Point-to-Point Protocol (PPP) over an RS-232 link instead of an
Ethernet link.

— Modem Modem

? Wy " L
SNAP PAC R-series

Computer Telephone lines controllerand /0 on
rack

The system can dial out to a PC connected to a modem, or the PC can dial into the system, or both. If the
system is also communicating via Ethernet, the network ID for the PPP interface on the controller must be
different from the controller’s Ethernet IP network ID.

For more details on configuring the controller for use with a modem, see “Using PPP Over a Modem”on
page 11.

Network Architecture Diagrams

Because SNAP PAC R-series controllers have two Ethernet interfaces and an RS-232 serial interface, these
controllers are suitable for use in a variety of system layouts and architectures. For example, the independent
Ethernet interfaces let you configure a network for link redundancy or isolating networks into zones. As
described in the previous section, the PPP serial interface provides a dial-up modem link for remotely located
control systems. The serial interface can also be used to connect a serial device such as a barcode scanner.
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Basic Control Network

The following diagram shows a SNAP PAC R-series controller that uses one network interface to communicate
with host computers and control I/0. The controller controls I/O on its own rack and on other SNAP PAC /0
units.

Basic Control Network
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Network Zoning: Ethernet Connections to Host and 1/0 Units

The following diagram shows two Opto 22 I/0 units connected together over an Ethernet network (a trusted
network) and controlled by a SNAP PAC R-series controller running a PAC Control strategy.

The controller is also connected to a larger, separate enterprise Ethernet network (an untrusted network) to
provide data to PCs running Opto 22's PAC Display HMI software, OptoOPCServer, and OptoDatalink. Sitting
between the two networks, the SNAP PAC R-series controller isolates enterprise traffic from the control

network, separating the two networks into zones.

The network shown in this diagram requires PAC Project Professional.

Control Network

Additional I/0 units are controlled by
the R- series controller on an isolated
network.

Field devices
location #1

Field devices
location #2

SNAP PAC R-series controller controls I/O directly on the rack and through one Ethernet interface, using
the second interface to isolate this trusted control network from the untrusted enterprise network.

Enterprise Network

= =
=)
PCrunning
Display OptoOPCServer and
Professional OptoDatalink
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|

|

|
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|

Ethernet switch,
network #1
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Ethernet Link Redundancy

The following diagram shows two SNAP PAC R-series controllers functioning as I/0 unit brains connected to
two separate Ethernet networks. This configuration addresses the concern that an Ethernet network may fail
or need maintenance, leaving the PC running OptoOPCServer, the PC running PAC Display, the controller, and
the /0 units unable to communicate. The network shown in this diagram requires PAC Control Professional,
PAC Display Professional, and OptoDataLink.

Opto 22 Redundant Network

= PC with two NICs running PAC
Display Professional

PAC Display

PC with two NICs running
OptoOPCServer

- SNAP PAC S-series

SREREREREEE conollerconmolsall - STTSlTeTaTeIg
Ethernet switch, ’ unes. Ethernet switch,
network #1 network #2

SNAP PAC R-series
controller

Sensors & actuators,
location #1

SNAP PAC R-series
controller

/0 units are all connected by the controller. Each
| 170 unit is connected to its own group of sensors
| and actuators, but all are connected to the same
| two networks.

Sensors & actuators,
location #2

In this configuration, if one network goes down, devices can still communicate because the SNAP PAC S-series
controller and the SNAP PAC R-series controllers both have two network interfaces, and each PCin this system
has two network interface cards.

NOTE: If you need controller redundancy (two controllers running concurrently, with one able to take over if the other
fails), use SNAP PAC S-series standalone controllers with the PAC Redundancy Option Kit and PAC Control
Professional. For more information, see the Opto 22 website.
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SPECIFICATIONS, CONNECTORS, AND DIMENSIONS
Specifications for SNAP-PAC-R1 and -R2 Controllers

Processor
Memory
Total RAM

Battery-backed RAM
Flash

Removable storage

Backup battery

Communication
Ethernet

RS-232 serial

I/O unit compatibility

Power requirements
Hold-down screw
Connector screw

Environmental
Operating temperature
Storage temperature
Humidity

Software
PAC Project Basic
PAC Project Professional

RESTful API3

Number of charts that can run
simultaneously

Agency approvals and certifi-
cations

Warranty

Other features

200 MHz 32-bit ColdFire® 5475 with integrated floating-point unit (FPU)

16 MB (5 MB available for PAC Control strategy and 2 MB for file storage)

2 MB (1 MB available for PAC Control strategy)
8 MB (3.25 MB available for PAC Control strategy; 384 KB available for file storage)

(Models with manufacture dates of November 2008 and newer. Requires firmware R9.4a or higher and
loader R6.1a or higher) MicroSD card slot: supports microSD or microSDHC cards to 32 GB.
(Note: Models with card slots and firmware R8.4 through R9.3e support microSD cards up to 2 GB only.)

Rechargeable (recharges whenever the brain has power), 3-year power-off data retention (replacement
part number: SNAP-PAC-BATTERY-ML2430)’

Two independent 10/100 Mbps Ethernet network interfaces (RJ-45 connectors). Each interface has a
separate IP address. Connects to host and I/O. Supports Auto MDI-X (crossover cable not needed)
One RS-232 serial port2 with hardware handshaking. Connects to host (via modem and PPP) or serial
device. Cannot connect to serial I/O.

SNAP PAC I/O units: SNAP PAC R-series and EB-series I/0O units
groov RIO edge I/O units
groov EPIC I/O units

5.0-52VDC @ 1.5A
Torque: 8 in-Ib (0.9 N-m)
Torque: 1.7 in-lb (0.19 N-m)

-20°C to 60 °C
-40°Cto85°C
0% to 95% relative humidity, non-condensing

Includes programming, HMI software, and configuration software; included with purchase of controller.
PAC Project Basic plus OPC 2.0-compliant OPC server, database connectivity, OptoControl strategy and
OptoDisplay project importing, and support for Ethernet link redundancy or network segmenting.

Use HTTPS to access data (read/write or read-only) from controller tags using your chosen program-
ming language. Data returned in JSON. More information at developer.opto22.com

16

All models: DFARS, CE, RoHS
All models except -FM models: UL
(-FM and -B models only) Factory Mutual approved, ATEX

30 months from date of manufacture

* Multiple protocol support including TCP/IP, HTTP/HTTPS, FTP, EtherNet/IP, Modbus/TCP,
SNMP v2.0c, OptoMMP ™ and SMTP

* Built-in I/O processor handles up to 16 digital4, analog, and serial I/O modules on the same rack

* Real-time clock

» FTP server/client with file system (in RAM and in removable storage)

« Scratch Pad area for peer-to-peer communication

+ Configurable link redundancy or segmented networking
for 1/0O-controller subnetting (when using PAC Project Professional)

" Models manufactured before July 1, 2007 have a user-replaceable 3-volt CR2032 Lithium battery (typical service life with power off: 5

years).

2 Connecting to a serial device requires configuration in PAC Manager; PAC Control handles communication.

g Requires firmware R9.5a or higher.

4 SNAP-PAC-R1s with serial numbers lower than 600,000, and all SNAP-PAC-R1-Bs, are limited to eight 4-channel digital modules per
rack; remaining eight can be analog, serial, and high-density digital modules.
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Connectors and LEDs

The following information applies to all SNAP PAC R-series controllers. For LED blink codes, see page 49.

Ethernet LEDs

\

Controller /

reset button

Independent 10/100 Mbps
Ethernet interfaces
(RJ-45 connectors)

=_|;::_|_¢:::;x
S383Fang
]

Status and Activity LEDs

Indicator Description

ACT
LNK

STAT

232
PPP

Ethernet network activity
Link established with Ethernet network

Startup status, control program opera-
tional status, MicroSD card access

RS-232 serial activity
PPP status

|: S-232 serial

communications

7 N
+ S
C OPTO 222 C
m SNAP PAC -
z SNAP-PACR1 Z )
MR, micco ] MicroSD
m Cad M
= Q' h — card slot
oee
589N\
= Status and
| &

activity LEDs

RS-232 Port (Port 0)

Pin Description

1 TX

RX
COM
RTS
CTS
COM
DTR
DCD

© N o a b~ W DN

RS-232 Serial Cable Wiring*

PC Controller
DB9
RX 2 1 TX
X 3 2 RX
SIGNAL 5 » 3 COM
GROUND \_ 6 COM

*Minimum requirements for wiring an RS-232 serial cable to
connect to a PC. If you want to connect the controller to a
modem, see page 12 for all eight pin connections.
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Dimensions

The dimensions are the same for all SNAP PAC R-series controllers.

3.313" (84.15mm)
(© OPTO 22 ©)
SNAP PAC
,E,. SNAP-PAC-R1 . %
o [N
o [eseeeesns] © © ©
© ©
~ Y,
i
Loggooio B
= i
A
381"
4.188"
(106.375mm) (96.77mm)
3.69"
(93.726mm)
! 1 v

1,75 (44, 4dmm) — =]
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All SNAP PAC R-series controllers offer many features, described in the following sections and summarized in
the table on page 33.

Digital Point Features

To configure digital point features, see the PAC Control User’s Guide. (Or PAC Manager User’s Guide, if you are not
using PAC Control. As noted below, some features require PAC Control.)

Latches—When the value of a digital input point changes from off to on, an on-latch is automatically set.
While the value of the point may return to off, the on-latch remains set until cleared, as a record of the change.
Similarly, an off-latch is set when the value of a digital point changes from on to off, and it remains set until
cleared. Latching is automatic and needs no configuration.

Watchdogs—You can set a watchdog to monitor communication with the PC or other host device. If the
host does not write data to the controller for the length of time set in the watchdog, the controller
automatically sets digital and analog I/0 points to values you have chosen. This action makes sure the process
is brought to a safe state if communication fails.

High-speed counters—(R1 only) Any standard or high-density digital input can be used as a counter,
counting the number of times the input changes from off to on. High-density digital points always act as
counters without needing configuration. Standard digital points must be configured as counters; as soon as it
is configured, the counter is automatically activated. The speed of the counter depends on the speed of the
module.

Quadrature counters—(R1 only) When you configure points on a quadrature input module (SNAP-IDC5Q),
the quadrature counter feature is automatically included. You can read the quadrature count from either point
by reading the point's counter data.

Additional digital features—The following digital features are available when a SNAP PAC R-series
controller is used with PAC Control. These features are not currently available through PAC Manager or the
memory map. Use PAC Control commands to configure and access them. See the PAC Control User’s Guide for
more information.

«  TPO (time-proportional output)—Time-proportional output varies the duty cycle and the percentage of
on time within that cycle. TPO is often combined with a PID loop and used to control the output, for
example in a heater or oven.

«  Pulse generation—Includes continuous square waves, on-pulses, off-pulses, and N pulses. A pulse turns a
digital output on (or off) briefly, either once or for a specified number of times at a specified interval. A
digital square wave is a specific pattern of on and off states, repeated continuously.

«  Digital totalizing—Tracks the total amount of time that a digital input point is on or the total amount of
time it is off. Totalizing helps determine maintenance or use cycles.

«  On-pulse and off-pulse measurement—(R1 only) A pulse is a brief on (or off) state, usually repeated at a
specific interval. The controller can measure the first pulse, that is, the amount of time the input stays on
(or stays off).

«  Frequency Measurement—(R1 only) Frequency is the speed with which a digital point changes state. It's
usually measured in counts per second. For example, reading the frequency can help you determine the
speed of rotating machinery.

o Period Measurement—(R1 only) Period refers to the elapsed time for a complete on-off-on transition on a
digital point. Measurement starts on the first transition (either off-to-on or on-to-off) and stops on the
next transition of the same type.
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Analog Point Features

For information on configuring analog features, see the PAC Control User’s Guide or, if you are not using PAC
Control, the PAC Manager User’s Guide.

Watchdogs—You can set a watchdog to monitor communication with the PC or other host device. If the
host does not write data to the controller for the length of time set in the watchdog, the controller
automatically sets designated I/0 points to the values you have set. This action makes sure the process is
brought to a safe state if communication fails.

Scaling—You can scale analog input or output points so that the values make sense for your situation. For
example, you can scale a -5V to +5 V input point to show 0% to 100%.

Minimum and maximum values—The controller automatically keeps track of minimum and maximum
values. You can read these values at any time, for example, to record minimum and maximum temperatures.
You can also reset min/max values. For example, if you want to record the maximum temperature at point 2 in
each 24-hour period, you must reset the values after they are read each day.

Offset and gain—The controller can calculate offset and gain for analog input points. If a -50 mV to +50 mV
input receives signals that are slightly off (not exactly -50 mV at the lowest point, for example), the offset and
gain can be calculated so that values will appear accurately when read.

NOTE: If you are using Modbus/TCP or EtherNet/IR, you will need to calculate the offset and gain yourself. Then you
can write offset and gain values to the controller.

Output clamping—The controller can clamp values sent to analog output points so they do not go above or
below a specific limit. For example, if you are using a 0—10 VDC output module, but the device attached to
one of its points can handle a maximum of only 5VDC, you can set an upper clamp of 5 VDC for that point.
The values for upper and lower clamp are set in engineering units.

Average filter weight—The controller can use a filter weight to smooth analog input signals that are erratic
or change suddenly. See details in the PAC Manager User’s Guide.

Additional analog features—The following analog features are available when a SNAP PAC R-series
controller is used with PAC Control. These features are not currently available through PAC Manager or the
memory map. Use PAC Control commands to configure and access them. See the PAC Control User’s Guide for
more information.

«  Ramping—Some devices attached to analog outputs should not be abruptly stepped up or down,
because a sudden change might damage the equipment or cause other problems. Instead, you can
gradually ramp the device up or down to the desired value.

«  Analog totalizing—For an analog input, a totalizer accumulates readings by sampling the input point at
set intervals and storing the total value, for example to determine total flow based on a varying flow rate
signal.

Serial Communication

R-series PACs can communicate with serial devices either through the RS-232 connector on top of the
controller (Port 0) or though SNAP serial communication modules on the rack.

The default configuration for Port 0 is communication with a host PC using a modem and PPP. To

communicate with a serial device, first change Port 0's configuration in PAC Manager. Here are brief

instructions; for more details, see “Configuring Direct Communication to Serial Devices"in the PAC Manager

User’s Guide (form 1704).

1. In PAC Manager’s Inspect window, click Communications and choose Communication Port Control from
the pop-up menu.

2. ForCom Port 0, click PPP in the Control Function field and choose None from the list. Click Apply.

3. Save the configuration to flash memory.
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Communication through the RS-232 port is handled through PAC Control commands. See “Communication
Commands”in Chapter 10 of the PAC Control User’s Guide.

For additional serial connections, use SNAP serial communication modules. Most serial modules provide two
channels of serial data, typically to interface with printers, scales, chart recorders, RFID readers, orWiegand®
security devices. A Profibus” module provides one channel of data from Profibus DP devices. See the serial
module’s user's guide for details.

PID Loops

Proportional integral derivative (PID) loops are used to drive a variable, often from an analog input, toward a
desired value. The PID monitors the variable, compares it to the setpoint (the desired value) and calculates an
output that will push the variable very close to the setpoint. Temperature control is a typical application for a
PID.

Each SNAP PAC R-series controller can run up to 96 PID loops. PID loops run on the I/0 side, independently
from a PAC Control strategy. To use PID loops, configure them in PAC Control or PAC Manager, and use PAC
Control tuning tools for ease in debugging. See the PAC Control User’s Guide (form 1700) for more information.

Additional Features

For information on configuring additional features available in the SNAP PAC R-series controller, including
security and the use of protocols such as SNMP, SMTP, and FTP, see the PAC Manager User’s Guide.
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SNAP-PAC-R1 AND -R2 COMPARISON CHART

The following table compares SNAP PAC R-series controllers with firmware 9.4 or newer.
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point features On-pulse and off-pulse measurement " o o ([
Frequency and Period measurement-3 [ ) (] ([
TPO (time-proportional output)® o o [ ] ([ ([
Digital totalizing"-3 e o o o ]
Pulse generation (N pulses, continuous square wave, ° ° °
on-pulse, and off-pulse)?
i izati -bit floati int f
Thermocouple linearization (32-bit floating point for ° ° P ° P
linearized values)
Minimum/maximum values [ ) [ ) [ ) [ J (]
Offset and gain o o o ([ J ([
Scaling () () () o o
Analog I/O TPO (time-proportional output)? ® ) ® ) )
point features :
Output clamping o o o o o
Filter weight o o o ([ J ([
Watchdog timer o () () o ([
Analog totalizing® o (] ( ([ o
Ramping® () () () o o
High-density digital (HDD) modules (inputs and outputs) [ ) [ ) @ @ [
Serial communication modules o (] o o o
PID logic (maximum 96 PID loops per controller) [ ) [ ) @ @ [
Works with PAC Project software [ ) [ ) [ ) [ J [ ]
Runs PAC Control strategies o o o ([ J ([
Ethernet network (two independent network interfaces) [ ] [ ] [ ] [ ] [ )
Security for Ethernet network (IP filtering, port access) [ ] [ ] [ ] [ } [ )
OPC driver support o o o o o
Modbus/TCP (slave) [ ] o o o [
EtherNet/IP for communication with Allen-Bradley RSLogix PLCs [} [ [} [ [}
REST API (requires firmware R9.5a or higher) [ ) [ ) @ o [
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SNAP-PAC-R1AND -R2 COMPARISON CHART

FEATURE

SNAP-PAC-R1
SNAP-PAC-R2

HTTP/HTTPS (requires firmware R9.5a or higher)
OptoMMP memory-mapped protocol

SNMP (network management of 1/0 & variables)
PPP (dial-up and radio modems)

FTP server and client

Email (SMTP client)

UDP Streaming of I/O data to host

Serial port (RS-232)

Scratch Pad area—bits, floats, integers, strings
Digital events, alarm events, serial events
Event messages

Data logging in the controller

(I B B BN BN BN BN BN BN BN BN BN J SNAP-PAC-R1-FM
® 0 00606 0606 0606 0 0 0 O L ENE:

1/0 point data mirroring and memory map copying
Realtime clock (RTC)

®© 0 0606 06060606 0 0 0 0 0 O Ll vl

([ ([ ([

Mounting rack SNAP PAC racks B-series

Number of modules per mounting rack 4,8,12,0r 16 4,8,12, 16

8 4-ch digital,
8 serial,

16 analog or
HDD

16 digital (any type)
16 analog
8 serial

Module types and maximum numbers allowed
per 1/O unit (with largest rack)

1 4-channel digital modules only; not available on high-density digital modules

2 Requires a SNAP quadrature input module (SNAP-IDC5Q)

3 Requires PAC Control Professional 8.2 or newer, or PAC Control Basic 9.0 or newer
4 Requires a SNAP analog TPO module (SNAP-AOD-29)
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4: Maintenance and
Troubleshooting

This chapter includes maintenance and troubleshooting information for SNAP PAC R-series controllers.
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MAINTAINING THE SNAP PAC R-SERIES CONTROLLER

Backup Battery

The SNAP PAC R-series controller has a rechargeable battery that receives charging current whenever the
controller has power. It will retain data for up to three years with the power off.

NOTE: Models manufactured before July 1, 2007 have a user-replaceable 3-volt CR2032 Lithium battery (typical
service life with power off: 5 years).

Changing the Controller’s IP Address

If you know the SNAP PAC R-series controller’s IP address, see the PAC Manager User’s Guide for
instructions to change it.

If you do not know the IP address, first check the label on the side of the controller. There are multiple
labels, one for each Ethernet interface; the primary interface is labeled Ethernet 1. If you still don't know the
controller’s IP address, reset the controller to factory default settings following the instructions in “Resetting
the Controller," below, and then set the IP address as described in the PAC Manager User’s Guide.
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Loading New Firmware

Each SNAP PAC R-series controller contains firmware (sometimes referred to as the kernel), which is similar to
an operating system. If the firmware should become damaged, or if a new version of the firmware is released,
you can load new firmware to the controller following instructions in the PAC Manager User’s Guide.

You can also load firmware using a microSD card (on R-series PACs that have a microSD card slot). See “Using
the MicroSD Card” on page 37 for details.

CAUTION: Loading new firmware deletes your PAC Control strategy (even if stored to flash memory) and your
persistent variables. Make sure you have archived your strategy before loading new firmware.

Setting Time and Date

The SNAP PAC R-series controller's built-in clock is set at the factory. To change the time and date, see the
instructions in the PAC Manager User’s Guide.

Resetting the Controller

1. Carefully insert a straightened paperclip or stiff wire into the small hole labeled RESET.

2.

DO NOT hold the button down too long.

Depending on the type of reset you need, press and hold down the RESET button as described below.

NOTE: Do not reset the brain to hardware test mode unless Opto 22 Product Support tells you to.

Reset type How to use the reset button

Simple reset Press and release immediately

Press just until STAT LED turns
solid green (1-2 sec)

Restore factory
defaults

Press and wait while LED turns
solid green. Release when LED
starts to blink (2-5 sec)

Failsafe bootloader
mode

Press and hold until LED starts
blinking orange rapidly and con-
tinuously (> 5 sec)

Hardware test mode

What happens

Controller restarts.

Any files and the strategy are erased unless they
have been stored to flash memory. Archived strate-
gies are not erased.

Controller restarts.

If a microSD card is present and contains config-
uration, firmware, and/or strategy files—Files on
the microSD card overwrite what is in flash memory
and other files in flash memory are not erased.
Data files on the card are not affected.*

If no microSD card is present containing configu-
ration, firmware, or strategy files—All files, strategy,
archived strategy, persistent variables, and 1/O con-
figuration are erased from RAM and flash memory,
and IP addresses are reset to 0.0.0.0 and subnet
masks to 255.255.255.0.

Controller restarts.

Any files and the strategy are erased unless they
have been stored to flash memory. Archived strate-
gies are not erased.

Controller restarts.

Any files, strategy, archived strategy, and persistent
variables in RAM and flash memory are erased. /0O
configuration in flash is erased (R-series).

Data files on a microSD card are not affected.

IP addresses are reset to 0.0.0.0 and subnet masks
to 255.255.255.0.

Notes

If no microSD card is
present containing config-
uration, firmware, or strat-
egy files, you must
reassign the IP address
and subnet mask.

Cycle power to recover.
Result is the same as a
simple reset.

To recover, restore to fac-
tory defaults as described
above. You also must
reassign the IP address
and subnet mask.

* Example of Restoring factory defaults when a microSD card is present: Suppose the card contains a firmware file but no configuration
or strategy files. Restoring to factory defaults will leave the controller with the firmware from the card and configuration and strategy files
from flash memory. You will not have to reassign an IP address or download a strategy.
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Using the MicroSD Card

SNAP PAC controllers with a manufacturing date code of 11/08 (November 2008) and newer

have a microSD card slot in the top of the controller's case. On a controller with a microSD card ms-"'
slot, the STAT LED blinks briefly about once every five seconds, indicating that the controller is micro
checking to see if a card is in place. [=.]s§

IMPORTANT: Since the first release, card behavior has changed. If you are using firmware older
than R9.0a, follow the instructions in Using microSD with Older Controller Firmware Technical Note (form 2018)
instead of this document.

To determine firmware version, see page 40. To download the latest firmware (recommended), go to
www.opto22.com/site/downloads and filter by Firmware.

Card Type and Format

Use only cards with the microSD or microSDHC logos (shown above right). Also, be aware that card capacity,
formatting, and filename limits vary depending on your controller, its firmware and loader, and the card type
you are using:

Compatible Max card

Controller firmware cards Card format capacity Filename limits
Firmware 9.4a or higher microSDHC FAT32 32 GB Long names OK
and loader 6.1a or higher  mjcrosSD FAT32 or FAT16 2 GB Long names OK
R9.0a to R9.3e microSD FAT16 2GB 8 dot 3*

Lower than R9.0** microSD FAT16 2GB 8 dot 3*

* All files stored on the microSD card must be named with a maximum of eight characters in the name
plus three characters in the extension (8 dot 3 format), for example: datafile.txt

** The card behaves differently using firmware lower than R9.0. Follow the instructions in Using
microSD with Older Controller Firmware Technical Note (form 2018) instead of this document.

IMPORTANT: Minimum controller firmware version R9.4a and loader version R6.1a are required to use microSDHC
cards. For more information, see OptoKnowledgeBase article KB83929.

MicroSD/SDHC Card Uses

Note minimum requirements in the table above. The card can be used for several purposes:

«  Tostore data or files, which you can access using PAC Control commands or an FTP client. (PAC Manager
cannot be used to access data, because it cannot see the card’s directory.)

«  To quickly commission a replacement controller in the unlikely event that a controller fails.

«  To update firmware on the controller or on a serial communication module on the controller's rack. The
card provides a convenient way to update firmware on non-networked controllers. It's also useful if PAC
Manager is not available to update firmware.

«  Totemporarily boot the controller from firmware on the microSD card rather than from the firmware in
the controller, for example to test new firmware.

«  Toupdate, run, or test new PAC Control strategies if the controller is not on the network, if PAC Control
isn't available, or if you want to test a new strategy without erasing the existing one.
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The following table summarizes how to use the card; see the page in the last column for steps.

To do this When Put card in... Use this method See pg
Automate data storage and retrieval in PAC
Control logic: Use PAC Control commands and
Controller - o
file communication handles. Or use PAC Con-
Store/access data Anytime trol FTP communication handles. 39
Controller’ From a PC, use an FTP client.
PC with card Use Windows Explorer.
reader
Controller’ 1. Use PAC Manager Inspect window to store IP
address and configuration data to card.
2. Use PAC Control to make controller down-
In advance load (.cdf) file.
PC with card 3. Create a command file to load firmware.
reader 4. Copy .cdf file, command file, and firmware file
Replace failed to card.
controller using a 41
prepared card 1. Replace failed controller with a new one
(must be exactly same part number; must have
minimum firmware R9.x and loader R6.x).
If controller
fails Controller 2. Insert prepared card and turn on power.
3. Use controller’s Reset button to reset to
defaults from card. Strategy is saved to flash
memory.
Controller" or Use Windows Explorer or FTP client to co
In advance PC with card ) P Py
Try out controller reader new firmware to card.
firmware without
replacing current Insert prepared card intp controller and cycle 45
firmware To use Controller power. Controller ruqs firmware on card.
To go back to older firmware, remove card and
cycle power again.
Controller! or  Use PAC Control to make controller download
In advance PC with card  (.cdf) file; then use Windows Explorer or FTP
Try out new strategy reader client to put .cdf file on the card.
without replacing Insert prepared card into controller and cycle 47
current strategy power. Controller runs strategy from card.
To use Controller
To go back to older strategy, remove card and
cycle power again.
PC with card  Create command file; copy it and the firmware
In advance )
Update non-net- reader file to card.
worked controller 4 Insert card into controller. Controller runs firm- 44
with new firmware™ 14 yge Controller ware from card until reset. Use controller's
Reset button to save firmware to flash.2
. Use PAC Control to make controller download
PC with card e )
In advance reader (.cdf) file; then use Windows Explorer to copy
Update non-net- .cdf file to the card.
wprked controller4 Insert card into controller and cycle power. Con- 47
with new strategy troller runs new strategy from card until reset.
To use Controller

Use controller's Reset button to save strategy to
flash memory.2 3

1 Controller must be on same network segment as PC.
2 CAUTION: Before resetting, make sure you know what is on the card! ALL IP address and configuration
information, firmware, and strategy that exist on the card are saved to flash memory.
3 If you have firmware R9.x but a loader older than 6.x, the controller runs the new strategy from card until
reset, but the strategy cannot be saved to flash memory.
4 CAUTION: Persistent variables will be deleted.
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Storing and Accessing Data or Files

When inserted into the controller and accessed from a PC using FTP or PAC Control, the card appears as a
directory in the controller’s file system named: sdcard0 Just like a PC might show a thumb drive as a
directory named Removable Disk (E:), for example, the controller shows the card as a directory named
sdcard0.

IMPORTANT: Do NOT try to create this directory. When you look at the card in the controller, the card appears as
adirectory named sdcard0. When you look at the card in a card reader attached to your PC, you see the card reader’s
directory instead. When the card is in a card reader, you are already in the root of the card (that is, you are already
inside the sdcard0 directory).

For example, suppose you are looking at a card in a SNAP PAC controller with IP address 10.192.54.241. You
can see that this controller has three files in its regular file system, plus the card:

Files in PAC's file system microSD/SDHC card

— =
B fip://10.192.54.241/ =13
File Edit Wiew Favorites  Tod Help ","

@ Back - \J I? P ) seNech H:' Folders mp | x n '
Acdress | (@0 fepef10,192.54.241/ / viBe
Folders X Name/ + Size | Tvpe Modified
@ Desktop |5 sdeardn File Folder ) 11212009 9:29 AM
=] D My Documents @ ProfibusIntegerTable0l kxt 20 bytes  Text Document 12/18/2008 11:55 AM
(] :‘i My Computer E} ProfibusStringTable01 bxt 99 bytes  Text Document 12/18/2008 11:55 AM
\g My Metwork Places E] ProfibusSystemParameters, bxt 12 bytes  Text Document 12/18/2008 11:55 AM

2 Recycle Bin
H @ Internet Explorer

= 2l

= 2] sdcardo
< >
User: Anonyrmous 0 Internet

Within the sdcard0 directory on the controller (or the root if the card is in a card reader), you can create
other directories and create or add files. For a card formatted with FAT16, you can have up to 512 files or
directories in the root directory, and each subdirectory can have up to 65,534 files. Cards formatted with FAT32
have no restrictions on the number of files in the root. Note filename requirements in “Card Type and Format”
on page 37.

When the card is in the controller, you can access files on the card through PAC Control commands and from a
PC using FTP.

Use PAC Control commands just as you would with any other file in the controller’s file system. For help, see
“Using the Control Engine’s File System”in the PAC Control User’s Guide (form 1700). Remember to include the
card’s directory name in the path in the file communication handle, for example:

file:a, /sdcard0/VoltLog.txt

Note that the path separator is a forward slash (/), not a backward slash (\).

You can also use the FTP communication handle in PAC Control to manipulate files. See the section “Moving
Files via FTP"also in the PAC Control User’s Guide.

To move files to or from a PC, use any standard FTP software. (Don't use PAC Manager as the FTP client, as it
cannot see directories within the controller's file system). Remember to include the card’s directory name, for
example: ftp://192.168.1.1/sdcard0/
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NOTE: If you access the card when it is not in the controller (for example, in a card reader), the sdcardO directory does
not appear. Do NOT create it. The controller treats the card as a folder in the controllers file system.

Displaying Free Space on the Card

If you need to know how many free bytes are left on a microSD/SDHC card, you can use PAC Control or
PAC Manager to read this data from an address in the controller's memory map. In a PAC Control strategy, for
example, you could notify an operator if the card needs replacing, based on the number of bytes still unused.

1. Make sure the card is in the controller.

2. In PAC Control, use the command Read Number from I/0 Unit Memory Map to read memory map
address F7002204. Use Integer 32 Variable in Argument 2.

For more information, see “I/O Unit—Memory Map Commands”in the PAC Control User’s Guide, and see
“Read Number from 1/0 Unit Memory Map”in the PAC Control Command Reference (form 1701).

3. In PAC Manager, open the Inspect window for the controller. Click Other and choose Generic Read/Write
from the popup menu. In the Address field, type F7002204. From the Type list, choose 32-bit Integer.
Leave the Length as 1. Click Refresh.

The number of bytes appears in the Value column.

Checking Firmware and Loader Versions

Compatible cards and card functions depend on the controller's firmware and loader versions. Here’s how to
check them. The controller must be on the same network segment as the PC with PAC Manager.

1. Open PAC Manager and click the Inspect icon Q

2. Inthe Device Name field, enter the controller's name or IP address, or choose it from the drop-down list.
Click Status Read.

Loader and firmware version numbers appear near the center of the window:

2D Inspect Opto 22 Device — X

j 4| »| Options » | Status: | Status Read area last read at 08/01/18 13:47:55

Device Name: | R1

Status Read
Status Read
Status Write hDDRESS

Wireless LAN  »

DESCRIPTION VRLUE

~ Refresh |

0xFFFF FO030
OXFFFF FO30

0004
ooos

Powerup Clear Flag PUC Needed PUC Receiwved (0)
Busy Flag 0

Paint Config 0xFFFF F030 0018 (Loﬂder Version RG.Zb)
0xFFFF F030 0000 HMemory Map Version 1
TElEltEs 0xFFFF FO30 0230 G ne moct Devics Flash Memory
Digital Point 0xFFFF FO30 001C (Fimare Version R9.5e
0xFFFF FO30 00RO Firmware Version Date 07/11/2017
Analog Bank 0xFFFF FO30 00BO Firmware Version Time 11:38:56
Analog Point 0xFFFF F030 0020 Unit Type 0x00000074
High Density 0xFFFF F030 0080 Unit Description SNRP-PRC-R1
O0xFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision ({Day) 21
HEEd D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
0xFFFF FO30 024C 1/0 Coprocessor Firmware Version AO0.0&a

ScratchPad  »
Datalog

PID 3

0xFFFF FO30 0028 Installed Ram 33554432

ETHERNET 1 Interface

0xFFFF

S
Other »

F030

0040

DNS
ETHERNET 2 Interface

0xFFFF F030 002E MRC Rddress 00-00-00-03-2F-01
Events » 0xFFFF FO30 0034 IF RAddress 10.100.00.120
0xFFFF FO030 0038 Subnet Mask 255.255.100.0
Communications ¥ 0xFFFF FO30 003C Gateway 10.100.00.50

10.100.00.91

40

Close |

EY | ™ Auto Refresh | 15000  msec

New firmware versions and some new loader versions are available from our website, www.opto22.com.
To update the loader, see Updating the Loader on a SNAP Device (form 1789). For firmware, see “Loading
New Firmware”on page 36. Contact Opto 22 Product Support with any questions.
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Replacing a Controller

A microSD/SDHC card can be used to quickly commission a replacement controller in the unlikely event that
an existing controller fails. The card rapidly configures the replacement with the original controller’s IP address,
firmware, configuration, and strategy.

Preparing the card requires PAC Manager R9.0 or higher. You must prepare the card in advance and then keep it
in a safe place in case the controller fails.

The replacement controller must have exactly the same part number as the old controller (for example, a
SNAP-PAC-S1-W must be replaced by a SNAP-PAC-S1-W), and it must have minimum firmware R9.0a and
loader 6.0a. See page 40 to check versions.

CAUTION: Use the commissioning card only to replace a controller; it assigns the new PAC controller the same IP
address as the old one.

Prepare the Card In Advance.

1. Putablank card into the controller that you may need to replace.

2. Copy configuration data as follows:
a. Open PAC Manager if needed. In the main window, click the Inspect icon E‘
b. Inthe Device Name field, type the name (or IP address) of the device. Click Status Write.
c. Inthe Operation Command list, highlight Store configuration and IP settings to microSD.

X

=] Inspect Opto 22 Device —

;I Options »

Device Name: I 10.111.11.11 Status: IStams Write area last read at 05/02(16 16:30:29

Analog Foint |
High Density |

System 13 |
ScratchPad  » |
Data Log 3 |
FID L3
Events 3 |
Communications » |
Other 3 |

0xFFFF FO38 0054

Operation

Scanner Flaos

OptoMMP Device

microSD

Other

Restart Device from powerup

Store configuration to flash

Erase configuration from flash

Reset to defaults and Restart Device

A Send Command |

Store configuration and IP settings to microSD
Erase configuration and IF settings k

gm microSC

Erase firmware from microsD
Erase strategy from microSD

Switch to loader mode
Clear Digital Events - Expanded configuration
C!ear D!gital Events - Ol_d configuration w

0x 00000000

[~ Status Write
Status Read |
Status Write | Address | Description | Value ~ Refresh |
0xFFFF FO38 0004 Always BootP [DHCF On Powerup No 1 =
. 0xFFFF FO38 0008 Degrees FjC Degrees F R Iy |
WirelessLAN ¥ | OxFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable 0
0xFFFF FO38 0014 TCP Minimum Retransmission Timeout (msec) 250
Paint Config | OxFFFF FO38 0018 TCP Initial Retransmission Timeout (msec) 3000
0xFFFF FO338 001C  TCP Retransmission Attempts 5
Digital Bank | OxFFFF F038 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
= = OxFFFF FO38 0294 Digital Feature Scan Interval {msec) 1
Digital Point | 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank | OxFFFF FO38 0298 Cut Of Range Value (16-Bit) -32768.000
OxFFFF FO33 02B0  Out Of Range Value (32-Bit) -2147483648.000

™ Auto Refresh IJSUDD msec

d. Click Send Command.

The controller's IP settings and all configuration data are saved to the card in a file located at
/sdcard0/opto22/config/config.cfg.
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3. Prepare the strategy file:

a. Open your strategy in PAC Control. In Configure mode, choose File > Strategy Options. Click the
Download tab.

Strategy Options *
Archive Download  Sedal 140 Ports Redundancy Legacy

Flash Memory
[[1 Save strategy to flash memary after download
[ Set autorun flag after download

Background Downloading

[] Use background downloading and fast strategy updating

The controller must be configured for this feature using PAC Manager.

Download Compression
None Full

Start Strategy
[ Start strategy after download completes

Concel | [

Check the Set autorun flag after download box. Click OK.
¢.  Choose one of the following:

- Ifyou're using PAC Terminal Secure Strategy Distribution (SSD), follow the steps in PAC Terminal
SSD Technical Note (form 1762, available with purchase of PAC Terminal SSD) to create a
download file with the file extension .ssd.

- Otherwise, compile the strategy as a Control Engine Download file (.cdf) by right-clicking the
name of the control engine in the Strategy Tree and choosing Compile Control Engine
Download File from the pop-up menu.

The file is created in the same folder as the strategy, with a .cdf extension and a filename consisting
of the strategy’s name and the control engine’s name (for example, MyStrategy. MyEngine.cdf ).

d. (Firmware below R9.4a only): Rename the .cdf or .ssd strategy file to fit the 8 dot 3 filename format
for the microSD card (see “Card Type and Format”on page 37).

IMPORTANT: You must retain the correct file extension (.cdf or .ssd).

4. Remove the card from the controller and put it in a card reader attached to the PC. Prepare the firmware
file:
a. Locate the firmware file you want to upgrade to.
b. (Firmware below R9.4a only): Rename the file to fit the 8 dot 3 filename format.
For this file, do not keep the same file extension. Recommended naming scheme: PPP-TMM . mmb

where:
PPP = controller type (R1, R2)
T = R for release (or B for beta)
MM = major revision number
mm = minor revision number
b = build letter
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Example of an original firmware filename: snap-pac-r2-R9.0a.bin
Example of the same firmware file, renamed: R2-R9.0a
Create the firmware command file:
a. Using Notepad or a similar editor, create a text file named: command
Inthe command file, type the following command (CASE SENSITIVE):
Krn <file>
<file> is the firmware path and filename as the card sees it, so do not include the sdcard0 directory
in the path. If you're using Secure Strategy Distribution, <file> must include a valid signature. Here is
a sample command file:

Krn R2-R9.0a

b. InWindows Explorer, delete the .txt extension from the command file. Then right-click the
command file filename and choose Properties. In the General tab, click to put a checkmark in the
Read-only box. Click OK.

Copy files to the card:

a. Copythe command filetothe sdcard0 directory in the controller's file system.

b. Copy the firmware file tothe sdcard0 directory. This directory must contain only one firmware
file.

c. Inthe sdcard0 directory on the card, create a new directory and name it: strategy
Copy the renamed strategy file (.cdf or ssd) to the sdcard0/strategy directory.

The card is now ready to be used as a commissioning card to replace the controller.

Replacing the Failed Controller.

Before you start, make sure that the replacement controller:

Has exactly the same part number as the old controller (for example, a SNAP-PAC-S1-W must be replaced
by a SNAP-PAC-S1-W)

Has minimum firmware R9.0a and minimum loader R6.0a. To check firmware and loader versions in PAC
Manager, see page 40. You can download new firmware from our website; if you need a newer loader,
contact Product Support.

Follow these steps to replace the failed controller:

7.

Turn off the controller that failed. Put the new controller in its place but DO NOT apply power. Attach

network cables.

Insert the prepared microSD/SDHC card and turn on power to the controller.

Without waiting, carefully insert a straightened paperclip or stiff wire into the small hole on the controller

labeled RESET. Press and hold the Reset button just until the STAT LED turns solid green, and then

immediately release the button.

The IP address is assigned to the controller, and firmware, configuration data, and strategy are loaded into

RAM, in that order.

- Infirmware R9.2c and newer, IP address, firmware, configuration, and strategy are stored to flash and
the controller reboots running the new firmware. The STAT LED blinks steadily during this process
and then blinks two sets of three blinks—green to indicate success, or red to indicate failure.

- Infirmware R9.0-R9.2b, IP address, firmware and configuration are stored to flash and the controller
reboots running the new firmware and loads the new strategy. To store the strategy to flash, use the
Reset button again in exactly the same way.

When finished, a folder named backup is placed in the root directory of the card. The controller

restarts.

10. Wait until the STAT LED blinks only once every five seconds, and then remove the card.
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Updating Firmware

The card can also be used to update firmware if the controller is not on the network, or if PAC Manager isn't
available. The card can update both controller firmware and serial communication module firmware.

CAUTION: Before updating firmware, make sure you know what is on the card! Any IP address, configuration data,
and strategy on the card will be saved to flash memory along with the firmware. If you want only the firmware saved,
delete configuration and strateqy files from the card.

CAUTION: Updating firmware deletes your PAC Control strategy (even if stored to flash memory) and your
persistent variables. Make sure you have archived your strategy before loading new firmware.

1. Obtain the correct firmware file from our website, www.opto22.com. If you are using Secure Strategy
Distribution (SSD), the firmware must have the correct signature.

2. (Firmware below R9.4a only): Rename the firmware file to fit the 8 dot 3 filename format (see "Card Type
and Format”on page 37).

The original file extension does not have to be retained. To make sure the file is clearly identified, we
recommend a name such as the following: PPP-TMM.mmb where:

PPP = controller type (R1, R2)

T = R for release (or B for beta)
MM = major revision number

mm = minor revision number

b = build letter

Example of an original firmware filename: snap-pac-r2-R9.0a.bin
Example of the same firmware file, renamed: R2-R9.0a

3. Copy the firmware file to a blank card. If you don't have a blank card, delete the following directories and
their contents if they appear on the card:

/sdcard0/strategy
/sdcard0/boot
/sdcard0/opto22/config

You can write to the card in one of two ways: either use your PC to FTP files to the card in the controller, or
use a card reader with your PC and simply copy files with Windows Explorer.

4. Using Notepad or a similar text editor, create a command file named command.txt andsaveitinthe
root directory of the card. (If you are looking at the card in a card reader, save it in the root directory. If you
are looking at the card in the controller, save it in the directory named sdcardo0 ).

5. Inthe command file, include the following commands as needed, all in the same file. All commands are
CASE SENSITIVE.

To do this ‘ Use command Details

<file> is the firmware path and file as the card sees it, so do

not include sdcard0 directory in the path. The firmware file

can be compressed in gzip format or uncompressed. *
Install serial com- . <modpos> is the position of the module on the rack.
munication module ModKrn <file>, NOTE: If this file exists, it will be installed. Firmware check-
firmware <modpos> ing is impossible on serial modules.

CAUTION: Installing the wrong firmware on a serial mod-

ule will make the module unusable. Make sure you have

the correct firmware!
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To do this Use command Details

<file> is the firmware path and filename as the card sees it,
so do not include sdcard0 directory in the path. The firm-
ware file can be compressed in gzip format or uncom-
pressed.” If you're using Secure Strategy Distribution,
Install controller Krn <file> <file> must include a valid signature.
firmware NOTE: If installing both module and controller firmware,
make sure the ModKrn command comes before the Krn
command, as Krn resets the controller.
NOTE: Controller firmware will be installed only if it differs
from the current firmware.

* To gzip a file on Windows, use the utility at http://gnuwin32.sourceforge.net/packages/gzip.htm.
SNAP PAC cannot decompress files that were compressed with WinZip

The following sample command file updates firmware on the controller.

Krn R2-R9.0a

The following sample command file updates firmware on the controller and on two serial modules. The
update commands for the serial modules must be listed first. This file updates version R2.0a on an RS-232
serial module in slot 3, firmware version R1.3c on a motion control module (a special type of serial
module) in slot 6, and firmware version R9.4a on a SNAP-PAC-R2 controller. Note that the motion control
firmware is located in a directory named motion. Itdoesn't have to be in its own directory; module
and controller firmware files can be in the same directory or in separate directories, as you choose. If you
show a path in the command file, note that you must use a forward slash (/), not a backward slash (\).

ModKrn SCM-R2.0a, 3
ModKrn motion/MOT-R1.3c, 6
Krn R2-R9.4a

In Windows Explorer, delete the . txt file extension from the file so that the complete filename is only:
command Then right-click the command file and choose Properties. In the General tab, click to put a
check in the Read-only box. Click OK.

CAUTION: Make sure you know what is on the card before updating firmware! Any IP address, configuration,
or strategy data that exists on the card will also be saved to flash memory along with the firmware.

To update firmware, insert the card in the controller’s card slot. Carefully insert a straightened paper clip

or stiff wire into the small hole on the controller labeled ReSET. Press and hold the Reset button just until

the STAT LED turns solid green, and then immediately release the button.

Firmware is updated and saved to flash memory. (If IP address, configuration, or strategy files are on the

card, they are also saved to flash memory.) When finished, a file named response is placed in the root
directory of the card; this file indicates the success or failure of commands in the command file. Then the
controller restarts.

Wait until the STAT LED blinks only once every five seconds, and then remove the card.

Booting from Firmware on the Card

You can also boot the controller from firmware on the card, rather than from the firmware in flash memory, for
example to test new firmware before updating it on the controller.

You can write to the card in one of two ways: either use your PC to FTP files to the card in the controller, or use
a card reader with your PC and simply copy files with Windows Explorer.

NOTE: Controllers configured for Secure Strategy Distribution (SSD) cannot boot from the card.
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Locate the firmware file you wish to boot from.

2. (Firmware below R9.4a only): Rename the file to fit the 8 dot 3 filename format (see “Card Type and
Format”on page 37).

Recommended naming scheme: PPP-TMM.mmb where:

PPP = controller type (R1, R2)

T = R for release (or B for beta)
MM = major revision number

mm = minor revision number

b = build letter

Example of an original firmware filename: snap-pac-r2-R9.0a.bin
Example of the same firmware file, renamed: R2-R9.0a

3. Create a directory on the card in the root and name it: boot

Remember, if you are looking at the card in the controller, you create the boot directory in the
sdcard0 directory. If you are looking at the card in a card reader, create the boot directory at the top
level. The controller's file system treats the card as a directory named sdcard0.

4. Copy the renamed firmware file to the sdcard0/boot directory on the card.
Here's how it might appear if you are looking at the card in the controller:

0% ftp://10.192.54.241/sdcard0/boot/

File Edt View Favorites Tools Help ",'
e Back * () |1f /.' ) Search [17' Folders | | o | 3 x n '
Adcress |8 ftpif10,192,54.241 jsdcard0jboat] v Ese
Falders X Mame = Size  Tvpe Modified
@' Deskrop RZ-RE.4A 1.42MB 44 File 1/2/2009 1:53 PM

=] |,'_J My Documents
@ :J My Computer
=] ‘g My Mebwork Places
2 Recydle Bin
® @ Internet Explorer
= (£ 10.192.54.241
= @ sdcardd

oY

|~
e

User: Anomymous 0 Internet

IMPORTANT: The boot directory must contain only one firmware file. If it contains more than one, the wrong
firmware may be loaded.

5. Ifthe card contains a command file or any other firmware files, delete them.

6. To boot the controller from firmware on the card, turn the controller off and insert the card in the
controller's card slot. Turn the controller back on. (Or insert the card and then quickly push and release
the controller’s Reset button.)

If the boot directory exists on the card, the STAT LED blinks green three times, quickly. Firmware is loaded.
If the STAT LED blinks red, see “Blink Codes”in this chapter to determine the problem.

If the STAT LED blinks green two times, either the boot directory is not present, the firmware file is invalid
or does not match the controller, or the controller is an SSD controller.

When the STAT LED no longer blinks steadily, but blinks only once every five seconds, you can remove the
card. When the card is removed, the controller continues running the firmware on the card until power is
cycled or the controller is reset. If you need to know whether the controller booted from the card or from
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flash memory, use PAC Manager’s Inspect window to check the Status Read area. See the PAC Manager
User’s Guide for instructions.

Updating, Running, or Testing a Strategy

The card can also be used to update, run, or test a PAC Control strategy. This ability is useful when the
controller is not on the network or PAC Control isn't available. Both regular strategies and Secure Strategy
Distribution (SSD) strategies can be used.

You can write to the card in one of two ways: either use your PC to FTP files to the card in the controller, or use
a card reader with your PC and copy files with Windows Explorer.

CAUTION: Before saving to flash memory, make sure you know what is on the card! ALL IP address, configuration
data, and firmware on the card will be saved to flash along with the strategy. If you want only the strategy saved,
delete configuration and firmware files from the card.

1. In PAC Control Configure mode, choose File > Strategy Options. Click the Download tab.

Strategy Options X
Archive Download  Serial 140 Ports  Redundancy Legacy

Flash Memory
[1 Save strategy to flash memary after download
[1 Set autorun flag after download

Background Downloading
[] Use background downloading and fast strategy updating
The controller must be configured for this feature using PAC Manager.

Download Compression
None Full

Start Strategy
[ Start strategy after download completes

Cancel Help

2. Ifyou want to set the strategy to autorun, check the box Set autorun flag after download.

Autorun works if you insert the card and then turn on the controller; it has no effect if you insert the card

when the controller is already turned on. (If the controller is already turned on, the new strategy follows

the status of the existing strategy: if the existing strategy was running when the card was inserted, the
new strategy will run; otherwise, it will not.)

If you use background downloading, the controller will switch to the new strategy when the card is

inserted.

3. Click OK.

Choose one of the following:

a. [Ifyou're using PAC Terminal Secure Strategy Distribution (SSD), follow the steps in PAC Terminal SSD
Technical Note (form 1762, available with purchase of PAC Terminal SSD) to create a download file
with the file extension .ssd.

b. Otherwise, compile the strategy as a Control Engine Download file (.cdf) by right-clicking the name
of the control engine in the Strategy Tree and choosing Compile Control Engine Download File from
the pop-up menu.

The file is created in the same folder as the strategy, with a .cdf extension and a filename consisting
of the strategy’s name and the control engine’s name (for example, MyStrategy.MyEngine.cdf).
5. (Firmware below R9.4a only): Rename the .cdf or ssd strategy file to fit the 8 dot 3 filename format for the

microSD card (see “Card Type and Format”on page 37).
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10.

11.

IMPORTANT: You must retain the correct file extension (.cdf or .ssd).

Create a directory on the card in the root and name it: strategy

Remember, if you are looking at the card in the controller, you create the strategy directory inthe
sdcard0 directory. If you are looking at the card in a card reader, create the strategy directory at
the top level. The controller’s file system treats the card as a directory named sdcard0.

Copy the renamed strategy file to the sdcard0/strategy directory on the microSD card.
Here's an example of a strategy file in the strategy directory, looking at the card in the controller:

8% ftp://10.192.54.241/sdcard0/strategy/ FBEX
File Edit View Favorites Tools  Help ':;'
@ Back = _\J Iﬁ: /.__\J Search [E_“ Folders =" x n '

Address |_@ frpiff10.192.54. 241 [sdcardfstrategy v| Go
Folders x Mame Size | Tvpe Modified

(2} Deskrop - MATH,COF 107 KB COF File 1/2}2009 2:20 PM
uﬁ My Documents

d My Computer
\Q My Metwark Places
2 Recycle Bin
& Internet Explarer
= [$] 10.192.54.241
= @ sdcardd

@ boat

§strategy

- Strategy file

User: Anonyrmous e Internet

If you plan to save the strategy to flash memory, delete the following files and directories if they are on
the card:

Command file and firmware files
/sdcard0/boot
/sdcard0/opto22/config

NOTE: Ifthe controller has firmware R9.0a or newer and a loader version older than R6.0a, you cannot save the
strategy from the card to flash memory.

To update, run, or test the strategy, turn off the controller, put the card in, and turn the controller back on.

The controller loads the strategy from the card (verifying the signature if it is an .ssd file), switches to the
new strategy if you're using background downloading, and runs the new strategy if you set it to autorun.
If it's not set to autorun, you can start the strategy manually using PAC Control or PAC Terminal.

The STAT LED blinks steadily while the strategy is loading and then blinks two sets of three blinks—qgreen
to indicate success, or red to indicate failure. When the STAT LED no longer blinks steadily, but blinks only
once every five seconds, it has finished.

If you want to save the strategy to flash memory, carefully insert a straightened paperclip or stiff wire into
the small hole on the controller labeled ReSET. Press and hold the Reset button just until the STAT LED
turns solid green, and then immediately release the button.

The strategy is saved to flash memory. (If IP address, configuration, or firmware files are on the card, they
are also saved to flash memory.) Then the controller restarts.

Wait until the STAT LED blinks only once every five seconds, and then remove the card.
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Disabling or Enabling Firmware and Strategy Updates Via the Card

If you do not want anyone to be able to update firmware or strategies using a microSD/SDHC card, you can
disable this feature in the controller. (Enabled is the default.)

1. In PAC Manager, open the Inspect window for the controller.

2. Click Other and choose Generic Read/Write from the popup menu.

3. Inthe Address field, type F7002200. Choose 32-bit Integer as the Type.

4. Todisable firmware/strategy updates: In the Value column next to the address, type 0 (zero). Click
Apply.

5. Toenable firmware/strategy updates: In the Value column, type any value other than zero and click
Apply.

Blink Codes

See "Connectors and LEDs" on page 28 for the location of LEDs.

STAT LED

The STAT LED on the top of the SNAP PAC R-series controller uses blink codes to indicate controller operation
and status conditions. The blink codes can be useful during normal operation and when troubleshooting.

«  When the STAT LED steadily glows green it indicates that one or more flowcharts are running.
«  When the STAT LED steadily glows orange, it means the controller is on, and either:

—  Thereisn't any strategy in the controller, or

—  The strategy in the controller is stopped, or

- The strategy in the controller has run, and no flowcharts are currently running.

If your R-series PAC has a microSD card slot, the STAT LED:

«  Briefly blinks off once every five seconds when it checks to see if a card has been inserted into the card
slot.

«  Rapidly blinks when it is reading or writing to the card.
For more information on microSD, see “Using the MicroSD Card” on page 37.
If the STAT LED blinks green when the controller starts up, it indicates the following:

Number of Speed of

Blinks  Blinks Means
2 fast Loading firmware from Flash memory to SDRAM.
5 fast Default settings have been successfully restored.

(Loader versions 5.1b and older} Entering fail-safe boot-

7 fast loader mode. (See “Resetting the Controller” on page 36.)

If the STAT LED is blinking orange, it indicates the following:

Number of  Speed of

Blinks Blinks Means
. . There is a problem with the bootloader. Contact Product
(continuous) slow
Support.
. No IP address is assigned to the controller. This may also
(continuous) fast

indicate that the controller is in hardware test mode.

* About once per second
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If the STAT LED blinks red and green alternately, it indicates the following:

Number of Speed of Means

Blinks Blinks

(Loader versions 5.1c and newer) Entering fail-safe boot-

(continuous) fast loader mode. (See “Resetting the Controller” on page 36.)

If the STAT LED is blinking red, it indicates the following:

Number of Speed of

Blinks Blinks Means Problem and Workaround

Flash chips were not erased properly or programmed

2 slow Flash programming failure properly. Contact Product Support.

The firmware in the device is damaged. See Replac-
& slow Firmware CRC check failed. ing Damaged Firmware in chapter 6 of the
PAC Manager User’s Guide (form 1704).
4 slow Invalid MAC gd_dress or Contact Product Support.
hardware revision
Firmware or hardware problem. Check the power
5 slow Fatal error supply and connections before restarting. Call Prod-
uct Support if the error is repeated.

6 slow RAM error Contact Product Support.

Firmware or hardware problem. Confirm Ethernet
cables are connected. Try turning off power to the
controller and turning it back on again. Call Product
Support if the error is repeated.

7 slow Loader problem

Firmware failed to initialize

11 slow communications on Contact Product Support.
ETHERNET 1.
Firmware failed to initialize
12 slow communications on Contact Product Support.
ETHERNET 2.
13 slow Real-time clock failure Contact Product Support.
PPP LED

The programmable PPP LED must be set to PPP (the default) in order to indicate the current state of a PPP
connection. For more information on programming the PPP LED, see the PAC Manager User’s Guide
(form 1704) or the OptoMMP Protocol Guide, (form 1465).

The PPP LED blink codes are as follows:

Color of Speed of

LED  Blinks Means
Green Solid There is a PPP connection.
Green Slow A PPP connection is being established.
Orange Solid The controller is listening on its PPP port.

PPP is disconnecting. After disconnecting, if Incoming PPP is enabled in PAC Man-
Orange Slow ager, PPP listens for incoming calls. Otherwise, PPP enters Idle state (from which it
can initiate an outgoing call). To configure PPP, see the PAC Manager User’s Guide.

Red Slow The PPP service has been instructed to stop and is shutting down.

Off n/a The PPP connection is idle or disabled.
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232 LED
The 232 LED indicates the following:

Color of Means
LED
Green The controller is transmitting data.
Red The controller is receiving data.

Orange  The controller is transmitting and receiving data simultaneously.

TROUBLESHOOTING THE SNAP PAC R-SERIES CONTROLLER

If you encounter a problem while installing or using the SNAP PAC R-series controller, check the information in
this section. If you need to contact Opto 22 Product Support, see “For Help”on page 5.

Getting Device and Firmware Information

If you need to contact Opto 22 Product Support for assistance in using an /0 unit or controller, it is helpful to
have device and firmware information at hand before you call us.

1. Choose Start > Programs > Opto 22 > PAC Project > PAC Manager.
2. Inthe PAC Manager main window, click the Inspect button @

3. Inthe Device Name field, type the controller's name (normally the I/0 unit name you defined in PAC
Control; or you can type the controller’s IP address). Click Status Read.

=] Inspect Opto 22 Device EI_IéJ

Device Name: | 10,192,50,45 j Options ¥ Status: | Status Read area last read at 02/19/15 14:35:17

Status Read
Status Read
Status Write kXDDRESS DESCRIFTION VALUE = Refresh |

»

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0
Paint Config 0xFFFF F030 0018 Loader Version R6.2a
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version RS9.4b
0xFFFF FO30 00R0 Firmware Version Date 01/13/2015

Analog Bank 0xFFFF F030 00BO Firmware Version Time 13:40:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

+igh Denslty O0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Emazd D O0xFFFF FO30 024C  FEGA Version 16908544
OXFFFF FO30 0028 Installed Ram 33554432

Data Log 3

ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-99-R§6
s OXFFFF FO30 0034 IP Address 10.192.50.45
OXFFFF FO30 0038 Subnet Mask 255.255.192.0
Communications b OxFFFF FO30 003C Gateway 0.0.0.0
OXFFFF FO30 0040 DNS 0.0.0.0

Other 4 ETHERNET 2 Interface -
Close | Help | [™ AutoRefresh | 15000  msec

Keep this window open on your screen when you call Product Support.
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Communicating with the Controller

If you attempt to connect to the controller using its IP address and you cannot, first check the following:

o Make sure the controller has been turned on and the LNK and STAT LEDs for the connected Ethernet
interfaces are lit (see “Connectors and LEDs" on page 28.)

«  Make sure the controller is mounted on a SNAP PAC rack.
«  Make sure the controller's hold-down screw has been tightened so that it is firmly attached to the rack.

«  Verify that you typed in the correct address for the controller. Check the label on the side of the controller,
where the IP address should be written. There are two labels, one for each Ethernet port, so make sure to
look at the right one.

«  Make sure the controller has been assigned a valid IP address and subnet mask. SNAP PAC R-series
controllers come from the factory with a default IP address of 0.0.0.0, which is invalid. The default subnet
mask is 255.255.255.0. To assign an IP address and subnet mask, see the PAC Manager User’s Guide.

«  Make sure that no red LEDs on the controller are lit. A red LED could indicate a voltage supply problem.
Each controller should have its own power supply. The controller needs a minimum of 5.0 VDC,
measured at the rack.

«  Make sure you have up-to-date drivers installed on your computer’s Network Interface Card (NIC).
Contact your system administrator or the manufacturer of the card for help.

«  Make sure you have Administrator privileges on your computer and that any firewall in the computer
(such as the built-in firewall in Windows) is temporarily disabled before you try to assign or change IP
addresses, load firmware using PAC Manager’s Maintenance window, or work with files on the controller.
BootP and FTP cannot function through a firewall in the PC. Firewalls in a router are less likely to be a
problem unless certain ports (such as FTP client) have been blocked, either by default or on purpose.

Pinging the Controller

If you still cannot communicate with the controller after you have checked these items, try to reach it using
the PING protocol.

1. Choose Start > Programs > Accessories and open a command prompt.
2. Atthe prompt, type: ping [controller’s IP address]
For example, type: ping 10.192.54.40

If the controller responds, go to “Accessing the Controller with PAC Manager” on page 52.

If the PING command cannot be found, choose Start > Control Panel > Network. Make sure TCP/IP is
configured as a protocol and that an IP address and subnet mask are assigned.

If you see the message “Destination host route not defined,” the controller probably has an
inappropriate IP address and subnet mask. Make sure the [P address and subnet mask on the controller are
compatible with those on the computer. Follow the directions beginning on page 35 to check the IP address
and subnet mask on the controller, and change them if necessary.

If you see the message “No response from host,” check the following:

«  Arethe computer and controller correctly connected? Is the controller turned on?

«  Arethe IP address and subnet mask on the controller compatible with those on the computer?

« Isthe controller in reset mode? (Check for a blinking STAT LED. STAT blink codes are shown on page 49.)

If you still cannot ping the controller, contact Opto 22 Product Support. (See page 5.)

Accessing the Controller with PAC Manager

Once you know you can ping the controller, try to access it using PAC Manager. You will need to know the
controller's IP address.

1. If PAC Manager is not already open, choose Start > Programs > Opto 22 > PAC Project > PAC Manager.
The PAC Manager main window opens:
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p
=8| PAC Manager @

File Tools View Help

Dles|d| #|%le @ @ @

Ready v

2. Inthe PAC Manager main window, click the Inspect button

3. Inthe Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list). Press Enter or click Status Read.

Information from the controller is displayed in the window:

'l .
5] Inspect Opto 22 Device (=] Fed)  Dateandtime
Device Name: | 10.192.50.45 Ll Options » Status: IStztusR.aad area last read at 02/19/15 14:35:17 data was |a5t
read
- Status Read
Status Read |
e BDDRESS DESCRIFTION VALUE B Refresh
5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwved (0)
Wireless LAN 0xFFFF FO30 0008 Busy Flag 0 N
. Click to
Point Config 0xFFFF FO30 0018 Loader Version RE.23 d d
= OxFFFF FO30 0000 Memory Map Version 1 update data
Digi 0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Paint 0xFFFF FO30 001C Firmware Version R9.4b

0xFFFF FO30 00RAOD Firmware Version Date 01/13/2015

Analog Bank 0xFFFF FO30 00BO Firmware Version Time 13:40:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x00000072

High Density 0xFFFF FO30 0080 Unit Description SNAP-BAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21
System 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad b 0xFFFF FO30 024C  FPGA Version 16908544
0xFFFF FO30 0028 Installed Ram 33554432
Datalog *
ETHERNET 1 Interface
PID b 0xFFFF FO30 002E MAC Address 00-A0-3D-01-99-26
M 0xFFFF FO30 0034 IP RAddress 10.192.50.45
0xFFFF FO30 0038 Subnet Mask 255.255.192.0
Communications » 0xFEFF FO30 003C Gateway 0.0.0.0
0xFFFF FO30 0040 NS 0.0.0.0
Other » ETHERNET 2 Interface -
LI [~ AutoRefresh [ 15000 msec
L J

If information does not appear, contact Product Support. (See page 5.)

Solving Network Problems

If there are recurring problems in communicating with the controller, check your network. The wires, switches,
and so on in your Ethernet network are not part of the Opto 22 hardware, but any problems in your network
may affect communication with Opto 22 products.

Create a Network Diagram. First, create a network diagram and verify the following:
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Ethernet Errors

«  (able connectors are firmly inserted.

«  The switch has power. Switch LEDs indicate that the connection is up.
«  Neither the PC nor the controller uses the switch's uplink port.

«  The SNAP PAC R-series controller's LNK LED is lit.

Check Ethernet Errors. Next, use PAC Manager to check Ethernet errors reported by the controller. These
errors indicate network problems. You will need to know the controller's IP address.

1. Choose Start > Programs > Opto 22 > PAC Project > PAC Manager.

2. Inthe PAC Manager main window, click the Inspect icon Q .

3. Inthe IP Address field, type the IP address of the controller. Click Status Read.
4

Scroll down until you see the items Ethernet Errors: Late Collisions, Ethernet Errors: Excessive Collisions,
and Ethernet Errors: Others.

= e S

=] Inspect Opto 22 Device

i1 0 -H IS tatus Read area last read at 02/19/15 14:41:10

Device Name: | 10.192.50.45

Status Read
Status Read

j Options »

Status Write 0xFFFF F030 0068 TCP Retransmits 5 - Refresh |
0xFFFF F0O30 00&C TCP Idle Session Timeout (msec.) 240000
0xFFFF F030 0108 ICP Idle Session Timeout Count 1]

Wireless LAN >|
| [ |oxeEEE F030 0070

Ethernet Errors: Late

Point Canfin
)

ollisions 1]
Ethernet Errors: Excessive Collisions 0

OxFFFF FO30 0074
L Ethernet Errors: Others 0

0xFFFF F030 0078

Digital Bank

Digital Point 0xFFFF F030 007C Smart Modules Present 0xE3CO
{analog, serial, ete.)
Analog Bank 0xFFFF F030 011C  PID Loops Supported a6
0xFFFF FO30 0148 Digital Modules Supported 16
Analog Point
0xFFFF FO30 0100 Arcnet Reconfigs Detected a7

High Density
System 3

0xFFFF F030 0104
0xFFFF F030 0120

Arcnet Reconfigs Initiated by I/0 Unit 1
Arcnet Transmit Attempts Since Powerup 379980200

0xFFFF FO30 0128 Arcnet ACKs 379980193
ScatchPad  » 0xFFFF F030 0134 Arcnet Timeouts a =
0xFFFF FO30 0124 Arcnet Other (node not found, etc) k]
Data Log 3 0xFFFF FO30 0130 Arcnet Timeout Value (msec.) [u]
0xFFFF FO30 0138 Arcnet Receive Interrupts 379980187
PID 3
0xFFFF FO30 0110 Ethernet MAC Resets Since Powerup [u]

Events 3
Communications
Other 3

Close | Help |

0xFFFF F030 0114
0xFFFF F030 0118

Dig. Output Point Resets Since Powerup 0
Dig. Interrupt Failures Since Powerup 0

0xFFFF FO30 0140 Analog & High Density Digital Scanner 2.020 msec/scan -

™ AutoRefresh | 15000  msec

All three of these items should have a value of zero. If any of these items has a value other than zero, you may
have a network problem.

Analyze Communication Packets. If it appears that you have network problems, you can use the
OptoEnetSniﬁw utility to log and analyze network communication packets. The utility is included with PAC
Project Basic and PAC Project Professional software suites, and is available on our website, www.opto22.com.
For help using the utility, see its online help file (choose Help > Contents).

Have Your Network Certified. If you suspect network problems, you may need to have your network
professionally certified. Opto 22 does not offer network validation or certification services, but many network
hardware manufacturers do. Contact the manufacturer of your Ethernet network hardware to have them
diagnose, fix, and certify your network.

If you continue to have problems communicating with the SNAP PAC R-series controller after your network is
certified, contact Opto 22 Product Support. (See page 5.)

SNAP PAC R-Series Controller User's Guide



CHAPTER 4: MAINTENANCE AND TROUBLESHOOTING

Additional Troubleshooting Tools

Making Sure the Controller is in Normal Mode

If you are having trouble communicating with the controller, it might be in fail-safe bootloader mode or
hardware test mode. The controller restarts in one of these modes if you hold down the RESET button longer
than the time needed to restore the default settings. For more information, see “Resetting the Controller”on
page 36.

TCP Settings

Retransmit timeout (RTO) refers to the length of time the controller waits while communicating before timing
out. The RTO is determined by the controller's TCP/IP stack, and the stack continually recalculates the RTO
based on recent network traffic. If the network becomes busier, for example, the stack automatically adjusts
the RTO to a higher value.

If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again. This
process continues for five retries; after that, the device stops trying and sends a timeout message.

If you are receiving frequent timeout messages from the device, you can change the TCP parameters in PAC
Manager.
1. Start PAC Manager:

- InWindows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project
10.0 > PAC Manager 10.0.

- InWindows 10, click the Windows Start button and type Opto 22 > PAC Manager 10.0.
2. Inthe PAC Manager main window, click the Inspect icon @

3. Inthe Device Name field, type the name or IP address of the controller.
Then, click Status Write.

=] Inspect Opto 22 Device EI_IéJ

Device Name: | 10,192.50.45 j Options # Status: | Status Write area last read at 02/19/15 14:45:45

Status Write
Status Read

Address | Description | Value 2 Refresh

OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo =1

. OxFFFF FO38 0008 Degrees FjC Degrees C = Apply

LEEELN D | OxFFFF F038 0010 _Comm Watchdog Time (msec), 0 = Disable 0 a =

0xFFFF F038 0014  TCP Minimum Retransmission Timeout {msec) 250

Point Config OxFFFF F038 0018 TCP Initial Retransmission Timeout {msec) 3000
0xFFFF FO338 001C  TCP Retransmission Attempts 5

Digital Bank | 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000

= = | UXFFFF FU3E U299 Digital Feature scan Interval (msec) T

Digital Paint 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

Analog Bank OxFFFF FO38 0298 Out Of Range Value -32758.000
OxFFFF FO38 0054  Scanner Flags 0x 00000000

Analog Paint 0xFFFF FO33 0154 Host Name =

High Density Operation
OptoMMP Device
| ptolv vice . . Send Commagﬂ " _

CAUTION: Note the following recommended settings:

TCP Minimum Retransmission Timeout (msec): 250
TCP Initial Retransmission Timeout (msec): 3000
TCP Retransmission Attempts: 5

TCP Idle Session Timeout (msec): 240,000

If you set these fields too low, you may not be able to communicate with the device at all—even through PAC
Manager—to fix the settings. Then you would have to reset the controller to factory defaults.
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4. Change these four fields as necessary:

Minimum RTO sets an absolute minimum value for the RTO. The device's calculated RTO will never go
below this value.

Initial RTO sets the RTO for the first communication try. Be careful: since all future tries are based on this
value, if you set it too low for network conditions, a connection will never be made.

TCP Retransmits sets the number of times the device retries communication. Larger, busier networks
need a higher number of retransmits than smaller networks with less traffic.

TCP idle session timeout sets how long (in milliseconds) the device allows a session to remain open
without any activity. After this time, the device checks the session to make sure it is still good, and closes
itif it is not. The default is 240,000 milliseconds, or four minutes.

5. Click the Apply button to write your changes to the controller.

6. Inthe Operation Commands list, highlight Store configuration to flash. Click Send Command.

7. Inthe Operation Commands list, highlight Restart brain from powerup. Click Send Command.
The new TCP parameters are set.
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SNAP Digital Troubleshooting

Q: I have a SNAP digital module that has stopped working. What may have caused this?

A: Failure of SNAP digital 1/0 modules is very rare and normally caused by misapplication, miswiring, or using
the module at the wrong logic voltage. As with Opto 22's other digital I/O module families, there is no one
way in which SNAP I/0 modules fail. Output modules normally fail in a different way than inputs.

Output modules usually fail open, or half-wave for AC, and the failure is typically caused by the application of
too much current or by degradation of the semiconductor switch by overvoltage. Because the module is
separated into two parts by the optical isolator, it is possible to have an output module that behaves properly
on the logic side but is broken on the field side. The LED will in most cases continue to turn on and off as
commanded by the driving logic device, even though the module has failed.

The first step to troubleshooting a failed output module is to check the fuse. If it is blown, simply replacing it
should get the module working again. If the module continues to blow fuses, analyze the load to see if the
module is really suitable for the application.

When input modules fail, they usually do so on the field side, typically from overvoltage or overcurrent
resulting from overvoltage. Unlike output modules, an input module’s LED normally will not function as
expected when the module has failed.

Q: I have an input module that seems to flicker when a voltage is applied to it. What is happening
here?

A: Some Opto 22 SNAP digital input modules contain full-wave rectifiers. In an AC application it is possible to
destroy one-half of the rectifier and still have the module appear to function. The full-wave rectifier turns into
a half-wave rectifier, causing the module to turn on and off at the line frequency when an input is applied. You
may see this as flicker on the channel status LED, or it may be too fast to see.

Digital logic devices, being much faster than the human eye, can cause serious issues with this failure mode.
For example, a digital counter attached to a failed module will count at the input frequency.

This failure occurs most commonly in applications where the input module is placed in parallel with an
inductive load. When the load turns off, the voltage spike (the back-EMF) goes right through the module,
destroying one-half of the bridge.
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To significantly reduce the frequency of this type of failure, place a transorb or large R-C snubber in parallel
with both the load and the input module.

Q: I have an output module driving a load. The load turns on but never seems to turn off, unless |
remove power from the module entirely. What might be happening?

A: This issue may occur when using an output module with a high-impedance load, such as a neon lamp or a
small solenoid. Loads like these often have relatively large initial currents but relatively small “hold-in"currents.
The result is that the off-state leakage current through the module is sufficient to keep the load on, once it has
been turned on.

The solution to this issue is to place a power resistor, sized for 8—10 times the rated maximum leakage current
for the module, in parallel with the load. Make sure that this resistor has a high enough power rating for the
application.

Q: | have a new AC output driving a solenoid. It turns on once, but will not turn on again. What is
going on?

A: Some loads, like certain solenoids, some types of halogen lights, and some types of strobe lights
incorporate a diode in series with the coil or filament. This causes the load to behave as a half-wave rectifier.

Opto 22 output modules have a built-in R-C snubber circuit in parallel with the output. The capacitor in this
circuit charges up but cannot discharge through the series diode, causing a voltage to appear across the
output terminals. Because the module must see a zero voltage across the terminals to come on, it can't turn
on again in this situation.

The solution is to find a lamp or solenoid that does not have an internal diode; a potential work-around would
be to put a high-value resistor (several tens of kilohms) across the output terminals of the module, to allow the
capacitor to drain.

Q: 1 have an AC output modaule in a circuit, wired in series (ANDed) with another contact. When that
other contact closes, my load turns on momentarily, even though my output module is off. Is my
module broken?

A: This situation arises when the output module does not see a voltage across its terminals. This occurs when
another contact is wired in series with the module, between the module and the “hot”side of the supply.
Because the module is totally isolated from field to logic, the field (or contact) side of the module must power
itself from the attached line. Because of the pilot circuit in the module, the switching semiconductor isin an
indeterminate state when there is no voltage across the module. It may turn on for up to a half cycle if it
suddenly receives power. The pilot circuit realizes that the module is on but cannot turn it off until the voltage
Crosses zero again.

There is no easy solution to this issue. Typically a solution involves either maintaining a minimal voltage across
the module, pre-wetting it with a low voltage, or absorbing the energy from the half-cycle turn-on with an
R-C network in parallel with the load.

Q: Why are all four loads connected to my SNAP output module coming on when I’'m activating only
one of the channels?

A:The SNAP digital output is likely connected on the wrong side of the loads. Remember that all four channels
share one fuse; thus one side of each output is common with one side of all the others. If the module is on the
wrong side of the load, any one channel is effectively connected to all four. If the output is a SNK type, try
switching to a SRC type, or vice versa. In AC applications, reverse the module wiring.

Q: | keep having failures on one channel of my SNAP output module. Why might this be happening?

A: Failures of only one of the four output channels would indicate an issue with the load being driven by that
channel. Make sure that the load characteristics, including transients, do not exceed the specifications of the
module. Also be sure that the module is properly transient protected, using either an R-C snubber (AC) or a
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commutating diode (DC) across the load. Modules may also be protected through the use of transient voltage
suppressors across the module itself.

SNAP Analog Troubleshooting

SNAP analog modules require a fairly substantial amount of current due to their onboard isolation power
inverters. Because of this, it is important to make certain that the entire SNAP installation is supplied with 5.0
to 5.2V, even while under full load.

See Opto 22 form #1120, SNAP Powver Supplies Data Sheet, for help in determining the full load required for an
I/0 unit, which includes the brain or on-the-rack controller and all modules.

An insufficient power supply really means a power supply that cannot provide the full load current required by
the brain and modules, or a power supply that is not adjusted to provide 5.00 to 5.20 VDC as measured at the
rack. The SNAP equipment is designed with a fail-safe voltage watchdog feature that inhibits operation when
power supply voltage levels get too low, thus eliminating the possibility of unintentional output or input.
Opto 22 offers DIN-rail-mountable power supplies for use with SNAP /0 systems.

Keep in mind that unless you purchase an isolated module, the channels on a SNAP input or output module
are not isolated from one another. Make certain that any transducers or equipment that these modules are
used with are floating, isolated from local earth ground. If the equipment is not floating, make certain that the
two pieces of equipment being connected are at the same ground potential in order to eliminate the
possibility of a ground loop through the module. A ground loop through the module could result in almost
anything, from inaccurate readings to failure of the module.
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A: SNAP Mounting Racks and
Power Supplies

INTRODUCTION

As shown in the illustration below, a SNAP PAC R-series 1/0 system has a SNAP PAC R-series controller, SNAP
rack, power supply, and modules. This appendix includes wiring diagram examples for assembling your SNAP
PAC R-series controller, SNAP PAC rack, and power supply. For more information, especially for wiring
information on modules, see the data sheet and the installation or user’s guide for your specific products.

Rack

— Power suppl
Controller PPY

O orrozz O
i ic
o e

Modules

SNAP MOUNTING RACKS

CAUTION: Make sure you are using the correct rack for your controller. Using the wrong rack will severely damage
the controller. Correct racks are shown below:

Use these controllers With these racks More info
SNAP-PAC-R1
SNAP-PAC-R1-FM SNAP-PAC-RCK4 SNAP-PAC-RCK12
SNAP-PAC-R1-W SNAP-PAC-RCK4-FM SNAP-PAC-RCK12-FM SNAP PAC Racks data
SNAP-PAC-R2 SNAP-PAC-RCK8 SNAP-PAC-RCK16 sheet (form 1684)
SNAP-PAC-R2-FM SNAP-PAC-RCK8-FM SNAP-PAC-RCK16-FM

SNAP-PAC-R2-W
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Use these controllers With these racks More info
SNAP-B4M SNAP-B12MC
SNAP-B8M SNAP-B12MC-P
SNAP-PAC-R1-B SNAP-BSMC SNAP-B16M oA ({{o O ook ;’ata
SNAP-BSMC-P SNAP-B16MC
SNAP-B12M SNAP-B16MC-P

In this guide, SNAP PAC mounting racks are shown in all illustrations.

SNAP PAC mounting racks can hold an I/0 processor (brain or rack-mounted controller) and up to 4, 8, 12, or
16 SNAP modules. A SNAP PAC rack is shown below with a SNAP PAC R-series controller installed, but no
modules. All wiring connections are made to the field connectors on the top of each module.
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SNAP-PAC-RK8
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Primary Power Supply

NOTE: For a more general discussion of using power supplies with Opto 22 systems, see the Using Power Supplies
with Opto 22 Systems technical note (form 1271).

SNAP PAC racks use a 5 VDC power source (5 VDC [-0.0, +0.1] at minimum 4.0 amps recommended). For
systems using AC source voltage, the SNAP-PS5 or SNAP-PS5U power supply is recommended. For DC
systems, such as those using DC backup power, the SNAP-PS5-24DC offers DC-to-DC power.

In general, we recommend you use an independent, isolated, regulated power supply locally with

each rack. Local isolated supplies offer these advantages:

«  Short supply conductors, which minimize losses

+  Power redundancy, so the failure of a single supply causes only a single rack failure, not a total system
failure

«  Fewer voltage drops and ground loops. (Voltage drops and subsequent ground loops may occur when
power is distributed over a large system.)

Always use a separate power supply for the field side of the /0. Using the rack supply for field actuation
and monitoring defeats the isolation the I/O module offers and therefore increases the chance of a ground
loop within the control system. Additionally, a sudden change of current on the field side can cause
undesirable voltage fluctuations that may interfere with the computer's operation.
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Determining Power Requirements

Both the SNAP-PS5 and the SNAP-PS5-24DC power supplies provide 5 VDC power for loads up to 4 amps. The
SNAP-PS5U provides 5 VDC for loads up to 5 amps. In most cases this power is sufficient for a SNAP processor,
arack, and the associated 1/0 modules. However, some combinations of modules, especially special-purpose
modules, may require additional power. You can use the following table to help determine power needs for
your I/0 units.

X Power Total Power

en ENEIL1T Req. (Amps) Required (Amps)
SNAP PAC R-series controller (except wired+wireless) 1 1.200 1.200 or
Wired+Wireless SNAP PAC R-series 1 1.500 1.500

SNAP-IDC5-SW digital input module

SNAP-IDC5-SW-NC digital input module

SNAP-AITM-8 analog input module 0.200
Isolated analog input and output modules (part numbers ending

in -i or iISRC) except SNAP-AITM-4i

All other 4-channel digital input and output modules except

mechanical relay outputs (not high-density digital modules) 0.050
SNAP mechanical power relay output modules 0.160
SNAP-AICTD, AICTD-4 analog input modules

High-density digital input and output modules

SNAP-AIMA-32, SNAP-AIMA-iH, SNAP-AIV-32, and 0.150
SNAP-AITM-4i analog input modules '

All analog output modules except SNAP-AOA-iSRC and

SNAP-AOD-29-HFi

SNAP-AOD-29-HFi 0.300
SNAP-AIPM power monitoring module 0.100
SNAP-AIPM-3, SNAP-AIPM-3V power monitoring modules '
SNAP-AILC and AILC-2 load cell modules 0.120
SNAP-AIRTD-8U analog input module 0.135

SNAP-AIARMS analog input module

SNAP-AIVRMS analog input module

SNAP-AICTD-8 analog input module

SNAP-AIMA, AIMA-4, and AIMA-8 analog input modules 0.170
SNAP-AITM and AITM-2 analog input modules

SNAP-AIMV-4 and AIMV2-4 analog input modules

SNAP-AIV, AlV-4, and AIV-8 analog input modules

SNAP-AIRTD analog input module
SNAP-AIR40K-4 analog input module

SNAP-AIR400K-8 analog input module 0.190
SNAP-AIRATE analog input module

SNAP-AIRATE-HFi analog input module 0.210
SNAP-SCM-ST2 and SNAP-SCM-SSI serial modules 0.200
SNAP-SCM-232, SNAP-SCM-485-422, SNAP-SCM-PROFI 0250
SNAP-SCM-MCH16 not powering a breakout board '
SNAP-SCM-MCH16 powering a breakout board 0.700

Total

1 Current from 5-volt supply

IMPORTANT: For a SNAP-PS5 or a SNAP-PS5-24DC power supply, the total power required must not exceed 4
amps. For a SNAP-PS5U, the total power required must not exceed 5 amps.
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Wiring the Primary Power Supply

Use one power supply per 1/0 unit. Use 14 AWG wire.

1. Mount the SNAP-PS5 or SNAP-PS5-24DC power supply so that the attached red and black power wires
will reach the + and — power terminals on the SNAP mounting rack.

2. Using the power terminals on the SNAP mounting rack, attach the red wire to the + terminal and the
black wire to the — terminal. Connect the ground terminal on the SNAP rack to ground.

3. Forthe SNAP-PS5 (notillustrated): Using the removable input power connector on top of the power
supply, apply 120 volts AC power between the two terminals marked “AC.” Connect the ground terminal
to ground.

4, Forthe SNAP-PS5U (not illustrated): Using the removable input power connector on top of the power
supply, apply 240 or 120 volts AC power between the two terminals marked “AC.” Connect the ground
terminal to ground.

5. Forthe SNAP-PS5-24DC (illustrated below): Using the removable input power connector on top of the
power supply, apply 24 volts DC power between the two terminals marked “+DC." Connect the ground
terminal to ground.

RED WIRE

BLACK WIRE

SNAP-P§5-24DC

/—+—‘ |
1
0 1 2 3
@ ) i - °or ar ar ar -
V @ 4 AMPS = ° ° @
LOGIC POWER SUPPLY N A = . 0o
8 FM> - [ j : <
E POWER N ™ N
5’, OFF “g _ ® @®
& a o
E . © 8 8 8 8
= | & ] ] a ]
@ Z < < < <
N u Az = = E 2 2
a v < < < <
N 24 il ' = ) ) -
o ik O , 2 N I E
24 R ] T N c Bz Mz Hs
o = . a ] o o
COM 0 s = W
+ O oo by @ 5 WY ®
FAST ETHERNET 1 J L | | | . _|
— ACTING . o
svon O oOPTO 22 10 o0
INPUT PWR - 30W MAX
® R e @ Ly \

Loop Power Supply

Some analog modules (SNAP-AIMA, SNAP-AIMA-4, SNAP-AIMA-i, SNAP-AIMA2-) also require a current loop
supply, which can be provided by the SNAP-PS24 or the SNAP-PS24U. Both offer 24 volts of DC power, the
SNAP-PS24 at .75 A and the SNAP-PS24U at 1.25 A. Follow these steps to wire these power supplies.

1. Mount the SNAP-PS24 or SNAP-PS24U power supply in a location where the attached output power
wires will reach the field connector for SNAP analog modules.

The white and red wire is the positive wire (24 VDC). The white and black wire is the negative wire (24
VDC return).

2. Ifyou are wiring directly to the module, see the wiring diagram for the specific module you are using.
Examples for an input module are shown in the following diagrams.
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SNAP-PS24
In this diagram, the SNAP-PS24 power supply supplies power directly to the input module. The SNAP-PS5
supplies power to the rack.

SNAP-PS24 SNAP-PS5 RED WIRE BLACK WIRE
s /
S| eams;
® @‘
24V @ 3/4 AMP 5V @ 4 AMP
POWER SUPPLY POWER SUPPLY
<FM> P CURRENT LOOP

RECEIVER

-l oN ~
POWER | ™= POWER in
OFF OFF

% 2 Ny,
o & 0c: o
< g kS 0o
% % aze B
. . ° S
- 5 % |
— 1 =
= = 0 B [ |
& & b c o
. ° I (C e W LS
o
)24\’1 oN O swoN QO oPTO 22
@ =it @f| Il | @ wenst @ | L
NS (S (P | NS S WHITE/BLACK WIRE —= WHITE/RED_p |
= WIRE
SNAP-PS24U

Here, the SNAP-PS24U power supply supplies power directly to the input module. The SNAP-PS5U
supplies power to the rack.

RED WIRE —
SNAP-PS24U SNAP-PS5U k A | BLACK WIRE
—
@@ roee o ® 2~ ® %¢ =
Ty 0 =
o CURRENT LOOP
orTo 22 orTO 22 N, RECEIVER
SNAP-PS24U SNAP-PS5U N &:
P ©
INPUT VOLTAGE, INPUT YOLTAGE, mZ2
100-250VAC 47-63 HZ 100-250VAC 47-63 HZ l z E
QUTPUT VOLTAGE, 0] v
Ertigteres 50 @ 3aws o
L A=
24VOLTS 5 VOLTS orPTO 22
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S 15 S
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I/0 modules, 7
modem, 12
mounting rack, /
power supplies, 60
Internet, accessing controller over, 14

J
JSON, 4

L

latches, 30

LEDs
232,51
blink codes, 49
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